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Purpose and scope
This manual is first  and foremost a reference manual, i.e. it deals mainly with 
how HAT works, not with what you can do with HAT.

Also, the main purpose is to describe the functions that are unique to HAT, not 
commands and techniques generally used in the operating system. It is assumed 
that you have already acquired this general knowledge, elsewhere.

HAT 4.1 works on different platforms (PC and Macintosh), and operating sys-
tems (Windows 3.1, Windows 95/98, Windows NT, MacOS 7, and MacOS 8). It 
looks very much alike on these platforms. Illustrations are basically from a Win-
dows 95 system. They may look somewhat different from what you see on your 
own screen. But the deviances are very small, and should not cause any ambigu-
ity. The few cases where the Macintosh version differs substantially, are marked 
as in the following remarks on few general differences that are only mentioned 
here:

MacOS
......................................................
•  Use the Command-button on Macintosh, instead of the Ctrl-button in Win-
dows
•  Use the Alt-button on Macintosh to get the function that is provided by F1 or 
the right mouse-button in Windows

......................................................•  Generally the Alt-button has the same function in both environments

The example file – Demo Inc
Many of the illustrations are based on the fictitious company Demo Inc, with a 
HAT-file based on its general ledger (accounting data). The data have this struc-
ture:

• The basic records are the accounting vouchers (called Cards in HAT), docu-
menting business transactions in the way this is regularly done in any 
accounting system. 

Each voucher has a date, some text describing the business transaction, and a 
number of accounting lines (two or more, as the values should add up to zero, 
balance, in an accounting system). The line entries are generically called 
Lines in HAT.

• Each transaction line in a voucher contains the fields:

– amount, in dollars (positive for debit, and negative for credit entries)

– the account 
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– the profit centre affected (in Demo Inc only for cost or revenue entries, 
not for entries affecting balance accounts)

– a field stating if it is an actual or a budget value

This description of the example file is not complete. It only serves as a general 
introduction, more details will follow later in this manual.

Navigating in the manual
The contents in the manual follows the logic of the HAT menus. You can keep it 
as a computer file and read it on the screen. But it is also designed to give a good 
printout, if you prefer. You may read the manual in different ways, depending on 
what you would like to achieve. If you are a new HAT user, you may initially 
want to read it as an ordinary textbook, from the first page to the last. Some pre-
fer to print it on paper for this specific use. Later on you will use it as a reference 
document, i.e. to look up certain commands or features. Then the electronic ver-
sion is much easier to work with. Use the free text search function (Find) in 
Acrobat Reader, or click in the contents catalog (to the left), to find the relevant 
section. 
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The rationale of HAT

The problem
Every organisation generates a lot of operational data as a result of its activities. 
These data constitute a source of potential information on the operations of the 
business. Information that is often badly needed, especially by managers at diffe-
rent levels. But the operational systems are not primarily designed with efficient 
analysis in mind. Usually they have some kind of report generator or executive 
information module that is built-in, or can be bought as an add-on software. 
Alas, they are – more often than not – rigid, difficult to work with, and slow. For 
example, in order to get reasonable response times, they often work with aggre-
gated data, to reduce the volumes. Resulting in analytical features which are very 
shallow. With software built on a lot of compromises like this, you should not be 
surprised that the resulting solutions to ”the management information problem” 
can only, at best, be characterised as half measures.

The HAT solution
The guiding principles behind the construction of HAT has been:

• It should be possible to analyse all kinds of operational data . Also combined 
data, from different sources (e.g. sales, accounting, and manufacturing data).

• Very large volumes (”mainframe volumes”) should be available to the analy-
ser, without aggregations and loss of details.

• The analysis should be very quick. It seems to be a common human trait, that 
a response time longer than a few seconds is frustrating, and reduces the 
motivation to do a proper analysis.

• The presentations should be easy to comprehend, flexible, and suited to the 
needs. Often a graphic overview is far better than a table of numbers. But you 
may also want to see the exact figures, in two decimal places. It all depends – 
and HAT should adapt to the instant need. 

• HAT should support a natural chain of thoughts. A certain compilation may 
not give the final answer, but rather raise new questions. By intuitive point-
and-clicking, you should be able to follow through, and get further informa-
tion and/or more detailed explanations.

Fundamental concepts

The reality

Business transactions and documents
It is hard to even think of an organisation that does not generate a lot of data. Not 
even the small one-man consultancy firm manages without a simple accounting 
system. At the other extreme we find the large company where the systems for 
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manufacturing, delivery, payment, storage etc each generates large volumes of 
data. Or a bank which may process millions of transactions per day. All these 
systems have one common denominator – at the entry point of the data into the 
computer systems, the fundamental entity is some kind of input document. Often 
this document is physically manifest in the form of one or many paper docu-
ments, but to a gradually larger extent these ”documents” only exists electroni-
cally. In whatever form, each document describes some sort of business 
transaction, and all the data relevant to this transaction are entered on the docu-
ment. 

The contents of the documents
Depending on the type of operational system, the input documents have different 
contents, of course. But a clear majority of them share a few common features:

• They contain one or many numerical values, e.g. representing dollars, num-
ber of sold units, number of hours worked, number of units delivered to the 
storage, etc.

• A time stamp of the business transaction. Usually the date, sometimes also 
hour, minute, etc describing when the transaction occurred.

• A number of attributes of the numerical values. Which account is affected, 
which profit centre should get the credit, what product(s) were involved, who 
sold it, where was it sold, … etc.

Obviously all these data constitute a potential resource of information, in search 
of the right tool to extract it.

The structure of data in HAT
Every useful database represents something external to itself – ”the reality”. The 
HAT database is constructed to make it easy to map data from the operational 
systems, as we know them, to the data structures available in HAT.

The two most important structural elements in a HAT database are: 

• The Cards/Lines record structure

• The Dimensions

Cards and Lines
Card is the the generic name of the basic unit in a HAT database. It is intended to 
represent a business transaction document, as mentioned above. I.e. it usually 
has a physical counterpart in the form of a voucher, an invoice, an account state-
ment, an order etc. But there are exceptions. In some cases we let HAT create 
”synthetic” Cards, i.e. Cards that exist only in the HAT database, without any 
exact correspondance to documents outside this database. E.g. we may let HAT 
group a flat file of sales transactions into separate Cards. 

Each Card has at least one Line – usually many. One Card can have two Lines 
and another two thousand Lines, it often varies a lot. The following example 
shows the general anatomy of a Card in HAT. In this case illustrated by an 
accounting voucher from the Demo Inc database:
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An intermediate level – Groups. Looked upon as a hierarchical structure of 
record types, one subordinate to the other – Cards are at the highest level, and 
Lines at the lowest. These are the practically and conceptually most important 
ones. But there is also an intermediate hierarchichal level, the Group.

Although not as important as the record structures of Cards and Lines, the Group 
structure can be useful in some applications. 

Example For a company consisting of many independent business units in with a lot of 
business transactions between them (internal transactions), you may want to do 
the entries for all parties involved in the transaction on the same Card. By trea-
ting the business units as Groups in the HAT application, you gain both practical 
and conceptual simplicity.

Dimensions
HAT is a multidimensional tool, with the option to use up to twelve user-defined 
dimensions. In addition, the time dimension is an intrinsic part of every HAT 
database. 

Card ID = Date+ordinal number Card Title

Notes

Lines

Card Header

Card Footer

Validation fields
(empty in this case)

Created/Modified fields

Card 1
Group 1

Line 1
Line 2

Group 2
Line 3
Line 4
Line 5

Card 2
Group 3

Line 6 … etc
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In the same way as a point in physical space is defined by its position in three 
dimensions, a business transaction is characterised by its ”coordinates” in a 
number of HAT dimensions. Each Line in a HAT database has exactly one 
numerical value. Depending on what type of data has been entered into HAT, 
each number gets different attributes. E.g. in the example file used in this 
manual, Demo Inc, each numerical value represents a dollar value. This dollar 
value has a date, affects an account, refers to a certain profit centre, and is either 
an actual outcome or a budget value. The following picture illustrates this parti-
cular case:

But it may look very different in another company, or for an another type of data. 
As in this case, where a lot more ”attributes” are registered for each value:

In the same way as we need a ”reference system” to define a point in the physical 
space, we work with Dimension charts, in a HAT application. For each type of 
attribute we use one HAT dimension. The dimension chart describes the internal 
structure of the dimension. The basic elements in a dimension chart are its com-
ponents. In the Accounts dimension, individual accounts are examples of such 
components. The components are usually structured hierarchically within the 
dimension chart. E.g. the Accounts dimension chart for Demo Inc has the follo-
wing structure (in outline only):

Account name
Account 
number

Assets

  Cash and Bank

      Cash

      Bank

          Postal Giro 1020

          PK-Bank 1046

          PK-Bank S-Account 1048

Other Current Assets

Fixed Assets

Liabilities and Equity

Revenues

Costs

$50

Actual/budget

Account

Profit Centre

Date

50

Actual/budget

Account

Profit Centre

Date

Product

Project

Region

Value type
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Most of the components in this overview, represents groups of subordinate com-
ponents. The components that have account numbers specified, are displayed at 
the lowest possible level. All other components have subcomponents, possibly 
thousands. The construction and use of dimension charts are explained further 
later in this manual. Dimension charts and their components are fundamental to 
the use of HAT.

Types of dimensions. All the twelve available dimensions, but one, are fully 
equivalent from all aspects. The exception is that a component you assign to the 
first dimension will always be treated as a Group. In many cases this special sta-
tus of the first dimension does not matter practically, and you may not even 
notice its special status. The example above, with internal transactions, is a case 
where it can be very useful.

HAT-data in the computer

The HAT database and the HAT-file
When you work with HAT, you are working with the database residing in RAM. 
This is what we call the HAT database. When this HAT database, or part of it, is 
stored on a permanent secondary medium, we call it a HAT-file. 

Structure of a HAT database
The HAT database consists of three major logical parts: 

1. the Cards database, i.e. the representation of all the raw data entered into 
HAT

2. the Dimension structures, i.e. the set of dimension charts with their internal 
hierarchical structures

3. the Parameters parts, i.e. collectively all the other data that is not included in 
the Cards database or Dimension structures. In this we find passwords, file 
dates, installed templates, etc. 

These are the logical parts of the HAT database, which we will refer to in this 
manual. 

Structure of a HAT-file
A HAT-file that corresponds to a fully developed HAT database, consists of a 
large number of different file sections. You may occasionally want to save only a 
part of a HAT database to a HAT-file, e.g. only the section containing the dimen-
sion charts. 

Three file formats
When a HAT database (or a section of it) is saved to a HAT-file, it is usually 
saved in the specific HAT-format called HAT-Normal (or just Normal, for short). 
As such it is encrypted (if a password has been defined) and compressed. 
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The other two formats are HAT-Text and HAT-Browser . When you choose to 
save the HAT Database in HAT-Text format, it will be an ordinary text file, which 
can be opened and examined by any text editor (e.g. Microsoft Word). 

The option to save the HAT Database in HAT-Browser format is only available if 
you have an HAT Server-processor installed on the computer. A HAT-file in 
HAT-Browser format can be opened and used by a HAT Browser-program.

When working in any flavour of Windows, these different types will get the 
extensions .HAT and .HAX, respectively. It is usually best not to change these 
extensions. You can associate all files with the .HAT and .HAX extension to the 
HAT application. The files will then show up with the HAT icon, and you can 
open them by double-clicking on their icon(s). 

MacOS
......................................................
Any HAT-file will automatically show up with the correct icon and will be ope-

......................................................ned by double-clicking the icon, regardless of its name.

Relation between a HAT database and its HAT-file
The relation between the logical parts of a HAT database, and the file sections in 
its HAT-file is illustrated in this table:

If you save a HAT-file in HAT-Text format, you can easily see these sections by 
opening it in a text editor (a section always starts with the characters ## followed 
by a name, e.g. the Cards section starts with ##Cards).

Logical part in 
the HAT database Sections in its HAT-file

Cards database Cards section (prece-
ded by ##Cards)

Dimension structu-
res

All dimension sections 
(preceded by ##Dimen-
sion 1, ##Dimension 2, 
etc)

Parameters parts All other sections
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Operating systems and hardware

Computer platforms
HAT 4.1 supports a number of different operating systems:

The different versions of HAT 4.0 works with the older Windows 3.1 (which is 
based on 16 bit technology). If needed, use e.g. HAT 4.0.4 on such systems.

The HAT-files are file compatible between these platforms, i.e. a file saved in one 
of these systems can be directly opened in the other, provided the same version 
of HAT is used on both platforms. As usual with all software, you cannot always 
expect to be able to open newly produced files, with older versions of the soft-
ware. HAT 4.0 vs HAT 4.1 is such a case – you can open an old HAT 4.0.x file 
with HAT 4.1 and later versions, but not the opposite way around (i.e. it is back-
ward compatible). 

Depending on operating system, you need different versions of the HAT pro-
gram. Consult the current product presentation (e.g. via Internet), to get latest 
information on this matter. 

HAT-processors
The regular HAT-program can only operate if a special PC Card, called HAT-pro-
cessor, is attached to the computer.Depending on type of HAT-processor diffe-
rent functionality is available:

Note that the same HAT-program is used, only the available type of HAT-proces-
sor determines what you can do with the program.

In the Microsoft Windows 
family

Windows 95 (32 bit)

Windows 98 (32 bit)

Windows NT 3.5 (32 bit)

Windows NT 4.0 (32 bit)

In the Macintosh family MacOS 7.0 or later, inclu-
ding MacOS 8 and 
PowerPC processors

   HAT-
processor

General 
funcionality

Special features
supports the operations

Analyser All types of 
analysis. 

          –           –

Operator All types of 
analysis.

Import text files, 
and create HAT 
Normal-files

          –

Server All types of 
analysis

Import text files, 
and create HAT 
Normal-files

Create 
HAT-Browser 
files
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To create HAT-Browser files you have to use a Server-processor. The distinguis-
hing feature of a HAT-Browser file is, that it can be opened (and used) with a 
special type of HAT program, the HAT Browser program, which does not require 
any HAT-processor. It has limited functionality, giving the user a kind of “inte-
ractive reports”, but no support for making fundamentally new types of analyses.

Multiple users
If a HAT file is located on a host server, several users can open the file simultan-
eously. If one user changes the database during a multiple user session, HAT will 
issue a warning to the other users.
AT 4.1 Reference Manual Version 1 (31/12/99) 2  General about HAT  13



3

The File Menu



3  The File Menu   

H

15
Introduction
Many of the File menu commands in HAT are standard operating system com-
mands. It is assumed that you are familiar with these. The commands that are 
specific to HAT will be explained in this chapter. If the command is disabled, it 
has no function in the current setting. Some commands also have a short cut as 
defined in the menu – e.g. Ctrl+S means that keeping the Control-key pressed, 
and simultaneously pressing the S-key will save the current HAT database to 
disk.

Commands in the File Menu

New
Will create a new empty HAT database.

Open…
Will open an existing HAT database. 

You can open several HAT-files simultaneously in HAT. The number of open 
files is limited only by the size of the files and the available internal memory.

You can also open up to three different HAT program files, of which each, in 
turn, can hold numerous different HAT databases. But you pay a price in terms 
of internal memory required. Each additional open HAT program file needs 
another 0,5 MB RAM.

If a HAT-file is located on a host server, several users can open the file simultan-
eously.

If the file previously has been saved with a password, you will be asked to enter 
the password. Type it and click OK. The password is not case-sensitive.
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The process of opening the database is displayed graphically. An estimate of the 
remaining time to open the file is shown.

Stop halts the loading of the file, and keeps the data that is already loaded. 
I.e.the database will be truncated.

Cancel cancels the process altogether, and deletes the data already loaded, from 
the internal memory.

You can switch control to another application and let HAT open the file in the 
background.

If you try to open the same HAT file more than once, a warning message is dis-
played. 

Information in the database window
The database window contains some basic information about the database:

If you click on the icon to the right, you will see a more elaborate description, 
with a number of statistics on the current database. Clicking on the icon is a 
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shortcut for activating the menu element Database Info, in the menu Database. 
Regardless of how it has been acitivated, it looks like this:

This Database Info window tells you 

• that the HAT-file (i.e. on disk) has the size of 364K bytes, and that it occupies 
1.5 MB of RAM when it has been read into the internal memory

• the number of Cards, Groups, and Lines

• how many text strings (Card Titles, Notes, and Line texts) that are included

• that there are 10 Analysis Templates installed; as no template is active, they 
currently use no internal memory

The meanings of All, Active and In Use are as follows:

All. All components in a dimension chart, e.g. 264 accounts in the chart of 
accounts.

Active. All components affected by Lines read, either by direct component 
coding or by accumulation to higher level components.

In Use. All components which are directly coded.
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E.g. for a chart of accounts:

Account in use (i.e. it is also active).

Account not in use by direct item coding, but active by accumulation to 
higher level items. 

Account  neither in use nor active.

In this example, the number of accounts in each category is:

The information in the Database Info window is updated continuously when it is 
open, which means that it consumes some processing power. So, if you do not 
need the information it is an advantage to close it. 

Close
Will close an open HAT database. If you have made changes to your database, a 
Save dialog will be displayed:

If you have not made any changes, a confirmation dialog will be displayed:

This is to prevent you from accidentally closing a database, that may take some 
time to reopen.

MacOS
......................................................
......................................................The Yes/No buttons have the names Save and Don´t Save.

Save
Will save the active HAT database to a file, without changing the name. If the 
HAT database is not changed, the command is dimmed.

All Active In Use

19 12 9
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Save As…
Will save the open HAT database to the place you choose, with the option to set 
a different name.

Save Special

Gives a multitude of options for what will be saved, and in what format. The set-

tings can be installed1 as a Save Setup, for further use at a later stage. As it is 
defined, or as a base template which you modify. You have to give it a name in 
order to be able to install it. 

In general you use Save Special to save the currently active HAT database, when 
you want to

• change the file format, and if it will be compressed or not

• save a selection of file sections and/or subset of Cards or Lines

• determine which dimension components are saved, and what dimension 
codes to use

• save a subset of the installed templates

• rearrange the order in which the dimensions appear

Save Special with the option New Save Setup will open a dialog window, 
with a number of tabs – every tab with its own settings. 

Formats

File Format. Choose between Normal, Browser, and Text. The Browser format 
is available only if you run the HAT program with a Server-processor (see sec-
tion “HAT-processors” on page 12).

Compressed. If the file is uncompressed, it will become larger but take a shor-
ter time to save and open. The difference is more significant for the saving opera-
tion.

1. Note that the operations Save and Install are not the same. When you save a 
HAT Database it is saved to a file, usually on a hard disk. When you install 
something (e.g. a Save Setup) it is inserted into the HAT Database, which 
resides in the internal memory. Not until you save the HAT Database, will it 
be saved to the hard disk, together with the other data in the database.
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Sections

• Default will mark all sections in the HAT database that are currently used. 

• Clear will unmark all sections.

Characters. Should normally be included. HAT-Text files may include this sec-
tion to ensure that international and special characters are correctly handled. Text 
files always use the native character set from the operating system, but when 
moving a text file over an operating system boundary, character conversion may 
or may not occur. If the Characters section is included in a text file, it will be 
converted in the same way as the rest of the file, ensuring a correct interpretion. 
If you are working in one operating system only, you can safely ignore this sec-
tion.

Protection. If a password is stated and this section is not included, the remain-
ing HAT-file will not be protected. Note also that a HAT-file saved in HAT-Text 
format will expose the password. It is therefore a good idea to exclude this sec-
tion, when you save a HAT-file as text.

Base Options. Will save your settings in Database Settings… See section 
“Database Settings...” on page 67.

Save Setups. Will save user defined Save Setups.

Import Setups. Will save user defined Import Setups.

Time Scales. Will save user defined Time Scales.

Dimensions. Will save all dimension charts. This setting can be further speci-
fied on another definition page – Dimensions.

Cards. Will save all Cards or Lines, as specified on the Cards definition page. 
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Subsets. Will save all subsets.

Analysis Templates. Will, if marked, save user defined analysis templates. 
Depending on the settings on definition page Templates, all templates, a ”filte-
red” subset, or only the currently open ones, will be saved. See section “Templa-
tes” on page 22.

Analysis Defaults. Will save all Set Defaults for each type of analysis.

Dimensions

When you save a HAT database or a part of the database as selected in Cards, 
you can decide to include All components, only Active components or only com-
ponents In Use, in a dimension. None will completely exclude the dimension. 
For an explanation of All, Active, and In Use, see section “Information in the 
database window” on page 16.

Cards
On this definition page you enter a selection in the same way as in an Analysis 
Template:

E.g. to produce a HAT-file containing only data for one single profit centre – 
enter its component in the Prof Cent box.

Only cards and lines needed for templates. If you want to reduce the 
database size to the bare minimum, without jeopardizing the data required to 
correctly show the installed templates, you can select this option. It is typically 
relevant when saving Browser-files. If a recipient of a a Browser-file uses a HAT 
Browser-program to open it, there is no point in providing data “outside” that 
defined by the set of templates, because they are invisible to the user. Occasio-
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nally the file size can be reduced substantially, which is often desirable if you 
enclose it in E-mails.

Selection  gives you the opportunity to save different parts of the Cards:

Templates

Specifies which templates are saved with the file.

Template Name Filter. The Template Name Filter acts as a selection crite-
rion on the name of the templates. The selection will be performed according to 
the rules of simple search texts. See section “Selection Boxes – Text” on page 
81, for more detailed information.

Example The filter ”key ratio” will save all templates which contain ”key ratio” in their 
names.

Currently Open Templates Only. You can also define what templates to 
save, by first opening them, and then tick this box.
This selection can be combined with the Template Name Filter.

Rearrangements
You may not be happy with the order between the dimensions in your HAT data-
base. With the exception of the first dimension (depending on its special status as 
Group), you can create a new HAT-file with the dimensions in another order.

Cards If at least one Line in a Card is inclu-
ded, the whole Card will be saved in the 
file. 

Groups If at least one Line in a Group is inclu-
ded, all the Lines in the Group will be 
saved.

Lines The Cards will be stripped from Lines 
not included in the selected subset (but 
all Card level data will be included).
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Dimension Numbering. You specify the new order under this heading. It is 
also possible to delete a dimension altogether. 

Dimension Codes in Cards. You can choose to save the HAT-Code, Host 
Code or Text. 

Install

Name for this Save Setup. When you open a new Save Setup, this box is 
empty. Not until you enter a name in this box, you will be able to install it in the 
HAT Database (i.e. in the internal memory). You install it by pressing the Install 
button. The installed Setups are then available in a submenu to the Save Special 
menu element. 

If you make changes in an active Save Setup that is already installed, and close 
the setup window, you will be asked if you would like to change it, or add it to 
the list of already installed setups. If you try to add another Save Setup with the 
same name as one that already exists, HAT will change its name by appending 
the first unused integer at the end of the name.

To delete a setup, you first have to make it active. Either use the Delete Save 
Setup command in the menu (which will then be active) or press the Remove 
button on the Install tab.

Save As ...
Press this button to initiate that the actual HAT Database is saved to a file, accor-
ding to your settings.
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Protection
You can specify a password that is required to view the data in a HAT Database. 
Often this password is enough. But you also have the option to increase security 
by demanding the use of a specific HAT-processor. More than one HAT-proces-
sor authorization can be specified. 

If you try to change the password, you have to enter the old one first.

A password can be up to 1023 characters long (letters, digits, or other charac-
ters). The password is not case-sensitive, i.e. the password

wordPASS

is equivalent to the password

WORdPass.

Warning!! The password only works as intended if the HAT database is saved in the Normal 
or Browser file formats. But if File Format is set to HT-Text, you should be care-
ful, not to expose the password in the HAT-Text file by mistake. It will turn up in 
the text file (easily read by using any common text editor) if the option Protec-
tion is marked. Therefore, as a rule, never save a HAT database in text format, 
without making sure that the entry Protection is unmarked. Unless you really 
want to show it, of course. If you anyhow try to save to a HAT-Text file with a 
password in it, the following dialog window will give you a last chance to 
change your mind:

Define password. Enter a password, and – if you want the additional security 
– the serial numbers of the authorized HAT-processors

Processor-IDs are not easy to remember. You may want to add a more descriptive 
text of your own choice, e.g. ”Clarks” in this case.

The file can now only be opened by a user who has any of the listed HAT-proces-
sors installed, and enters the correct password.
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Change/Remove password
You can change the password for a file that is already protected. First you will be 
asked to enter the current password.

If you leave the password field empty, the file will be saved without a password. 
However, you can still restrict the use of a file to a specific HAT-processor.

Preferences…

A few basic elements can be set in Preferences…. These settings define how 
the HAT application works for all your databases, collectively. The settings are 
stored in the user-specific part of the system registry:

Note the difference compared to Database Settings… in the Database menu, 
where the settings which will follow the specific HAT database/HAT-file.

General

Language
Will change the language in all parts of the HAT program, as soon as you close 
the Preferences window. 

User Interface
You can choose between the looks of Windows 3.1, Windows 95, MacOS 7, or 
Mac OS 8. Note that the change does not take effect immediately. You have to 
exit the HAT program, and start it again, to see the difference.

Dragging
Specifies how the drag operation works, e.g. when zooming in:

 Diagonal Center
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Alerts
Choose between Yes-No or Do-Don´t, as displayed alternatives in dialog boxes. 

MacOS
......................................................
For Macintosh you have the additional option of setting two Printing options, 
but there is no need to establish file associations (the MacOS maintains the cor-
responding functionality without involving the user): 

Color. Allows you to force the printer to print in black and white, or use color/
grayscale.
Resolution. Set the printing resolution to 1, 2, 3, or 4 times the screen resolu-
tion. Most printers produce the best result when ”*2” is selected. Some high 

......................................................resolution printers may produce better pictures if a higher resolution is used.

Check for File Updates
When more than one user operate on the same HAT database, HAT will issue a 
warning if the database has been changed by another user. If you uncheck this 
box, the warnings will be surpressed. 

System Setup

Associate File Types
HAT has a built-in functionality for making a quick and safe update of the Regis-
try, via this button. If you press the button, the current version of HAT will be 
opened when you double-click on a file icon of a file with one of the extensions 
.hat or .hax. These files will also appear with correct file symbols:

For further details on the file formats in HAT, see section “Three file formats” on 
page 10

Register/Unregister OLE-Server
Use these buttons if you want to start/stop using some of the OLE-services built 
into HAT. Usually there is no reason unregister the OLE-Server.

Print…
Standard Windows command. 

Extension Symbol
File name 
example

.hat DemoInc.hat

.hax DemoInc.hax
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Printer Setup...
Standard Windows command.

MacOS
......................................................
......................................................The command is called Page Setup…

Import Setups

Import Setups lets you specify how a text file should be interpretated when it is 
imported to HAT. Note that you need a HAT-processor of the Operator or Server 
types, to be able to import text files. 

In the sub-menu of Import Setups, you have the options to create a new setup, 
delete an existing one, or activate one of the setups already installed (from the 
list below the commands).

New Import Setup
Release the mouse button on this entry, and an empty setup will be created. If 
you make any change to this setup, and then close it, you will be asked if you 
want to add it to the list of setups. It will either get the name you have entered 
(see below) or HAT will automatically give it the name Import Setup 1 for the 
first setup, or append the first higher running number that is not already occu-
pied.

Delete Import Setup
This command is only available for an active Import Setup, so in order to delete 
a setup, first activate it from the installed list.

Definition pages in Import Setup

General

Import Setup Name
In this field you can give the Import Setup a name. 

Show File
By clicking the Show File... button you will be able to select an example file. 
The file you choose should have the same format as the file you intend to import, 
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or simply be this very file. This is not a necessary step in order to define the 
setup, but it often is of great help, when filling in the rest of the setup.

Example files can be shown in three formats (it is set to Text in the Import Setup 
above):

You choose the preferred format with the pop-up menu in the left margin.

Some displayed characters may look the same, but have different codes. Use the 
Hex Codes or Decimal Codes formats to see their exact definitions.

Example An example file could look like this, with the setting Text:

Hex Codes Characters are displayed as hexadecimal codes

Decimal Codes Characters displayed with decimal codes

Text Text characters are displayed as usual
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Characters

Character Set
The imported file should always be a text file. Depending on what computer pro-
duced the file, different code tables are used. Choose the character code table 
used in the imported file.

If you are not certain which code table to use, it is easy to try different settings, 
provided you have already opened an text file, with Show File. The effect of a 
changed setting will show up instantly.

Character Conversions
These two edit-boxes define straightforward character conversions. A character 
in the upper box will be replaced by the character at the same position, in the 
lower box. E.g. with the entries

every occurrence of the letter”Ç” will be replaced by the letter ”c”, ”ü” by ”y”, 
and ”å” by ”a”. The effect of a changed setting will show up instantly.

Exclude Chars
Specify all characters that you want to exclude completely, in this field. The 
exclusion affects all fields.

Note: Excluded characters are still regarded as positions for fields.

Format

Field Length
Choose between fixed or variable field lengths.

• Fixed fields are used if no character is used as a field separator, i.e. fields are 
defined solely by their start and end positions, counted from the start of a file 
row.
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• Variable fields are used if a field separator is present. In this case fields are 
defined by their field number. Occasionally only a part of such a field is rele-
vant. This part can be further specified by assigning start and end positions 
within the field, when its field number has been defined (see below).

Row Terminator
Usually the characters ”Return” or ”Linefeed” are used to define the end of a file 
row, but any character can be entered here.

You can use the #-character to specify a decimal character code. E. g. #13 repre-
sents the same character as ”Return”.

Field Separator
If variable field lengths are used, you have to enter the character that defines the 
border between consecutive fields. Very often ”Tab” is used as the field separator.

Decimal Separator
Defines the character separating the integer and decimal parts in value fields.

Exclude Rows
Text files often start with page headers, column titles, etc. I.e. file rows which are 
not relevant. The number in this box defines, how many leading file rows will be 
skipped at importation. The example file has one leading file row that is irrele-
vant:

Enter ’1’ in the Exclude rows box, and you will get:

The shaded area indicates that the first file row will be discarded, when 
importing the file.

Number of file rows for Cards
Defines the number of rows the Card information occupy. Multiple file rows are 
mapped as if they were a concatenated single line. E.g. if Date and Card Title 
occur in two consecutive but separate file rows, specifying 2 here, makes them 
accessible as if they were in one single file row.
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Number of file rows for Lines
Same as above, but refers to Lines instead of Cards.

Structure
On this definition page you describe how to divide file rows into Cards and 
Lines.

Card Switcher
This field definition can be used to group consecutive Lines, to form Cards. If a 
number of consecutive file rows have the same contents in the Card Switcher 
field, they will all be grouped in the same Card. When the contents changes, a 
new Card is generated. An empty field is regarded as unchanged.

Field definitions. The way in which fields are defined, is the same throughout 
the import format. In this particular case the definition page looks as follows (if 
Field Length is set to Variable, otherwise the field box is dimmed):

You enter a field number in the Field box and, if applicable, First and Last posi-
tions within this field.

By pressing the Add button, you create another set of entry boxes:

together with an Add and a Remove button. The effect of filling in both sets of 
entry boxes, will be that the two fields that are defined are concatenated, and 
conceived as one combined field. This concatenation can be extended to any 
number of fields. Thus, if date is to be used as a Card switcher, and day, month, 
and year occurs in different parts of the file rows, you can ”pick” the date parts 
from their locations, and combine them here, to one single date.

If you press the Remove button, the last column will disappear.
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Card Indicator
A file row for which the contents of this field exactly matches the char-

acters in the Indicator box, is considered as a row with Card data.

Line Indicator
Corresponds to the Card Indicator, but defines a file row with Line data.

Card Fields

Date
On this definition page you enter the positions for the Card date. You can also 
enter a Default value, e.g. a common date for all transactions imported in the 
same run. The default value will be entered into the HAT database if, and only if, 
there is no date value in the designated entry field.

Date Format. HAT can import a wide variety of different date formats, if only 
they are expressed numerically (i.e. ’8’ is accepted as a month, but ’August’ is 
not). Generally Y stands for year, M for month, and D for day. They can be 
expressed and ordered in different ways. Any characters, but for numbers, acts as 
separators between the date parts. 

Date in HAT and the ”millenium problem”. Many host systems store the 
year with two digits only, which makes a date such as 02/11/25 (in the format 
YY/MM/DD) ambiguous. Should it be interpreted as 1902/11/25 or 2002/11/25? 
HAT allows data to remain in this potentially ambiguous format, and solves the 
problem in a simple way:

Each date part has two digits, in the indicated 
order. Years are stated with two digits. If the host 
file has 4-digit years, deselect the leftmost two 
positions to exclude the century part.

The date parts occur in the indicated order. Years 
can be two or four digits. The parts are separated 
by any non-numerical character. 
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• All short format dates in the interval 28/01/01 - 99/12/31 are mapped on the 
dates 1928/01/01 - 1999/12/31

• All other dates, i.e. 00/01/01 - 27/12/31 are mapped on the dates 2000/01/01 
- 2027/12/31

Practically this means that the host system does not have to provide a four digit 
year value – HAT will work correctly anyhow.

New Components in Hierarchy
Imported data may contain host codes that are unknown to the HAT-application. 
HAT then creates a new component in the relevant dimension chart. 

Normally new components are added at the end of the dimension chart.

By ticking this option, you can instruct HAT to place new components in their 
natural hierarchical position, by using the host code as indicator of the HAT-
code. This requires that host codes and HAT-codes are almost identical.

Card Title and Notes

You have the option to convert the texts in these fields during importation, by 
choosing from the following list of alternatives:

The conversion will be performed exactly as indicated by the spelling in the pop 
up-menu, i.e. 

Other Card Fields
Created, Modified, Examined, and Approved are all treated in the same way 
as Card Title/Notes, with the minor difference that the Text Conversion ope-
ration is not available for these fields.

Line Fields

Introduction – Single versus Multiple Line Fields
The transaction values can occur in the imported file, in two different ways:

Imported 
string

UPPER 
CASE

lower 
case Standard

Word 
Caps

This is a 
STRING

THIS IS A 
STRING

this is a 
string

This is a 
string

This Is 
A String
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1. Transaction values are placed in one single position in the file rows (i.e. cor-
responding to one column).
Example:

This single value column structure only needs one Line Fields entry.

2. Each file row has many value fields. E.g. a matrix with three value columns: 
number of units, sales (in $), and product costs (in $).

This multiple value columns structure requires three Line Fields entries, 
simply because the values are found in three different positions in the file 
row. Note that these fields/columns do not necessarily have to be adjacent to 
each other, as they are in this example.

The case of single value column is described first, followed by a generalization 
to multiple value columns.

Specifying the Line Fields
 In the case of Demo Inc, the following fields have to be specified: Value, Line 
Text, and each of the dimensions: Act/Budg, Account, and Prof Centr.

The settings generally are very similar to the corresponding Cards Fields set-
tings. Only the ones that differ, will be commented here.

Value

Scale Values By. Some accounting software express all values in cents (i.e. 
skips the decimal point). HAT will multiply all imported transaction values with 
the factor in the Scale Value By box. 
I.e. if you want to convert cents to dollars, insert the value ’0.01’, to get the desi-
red result. 

… 100 NO Number of units …

… 35 DS Dollar Sales Value …

… 25 DC Dollar Cost …

… 250 NO …etc …

… 38 DS … …

… 21 DC … …

… 430 NO … …

… NO DS DC …

… 100 35 25 …

… 250 38 21 …

… 430 … … …

… … … … …
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Another use of this feature, is to make currency conversions already at the 
importation stage.

Exclude Zero Lines. Fill this in, and the corresponding Lines will not be ente-
red into the HAT database.

Dimension components
The field positions of e.g. the Account host codes have to be defined:

New Components. Determines what happens when HAT encounters a host 
code that is not included in the dimension chart. 

Multiple value columns structure
When you have many columns with different types of transaction values, you 
typically use one dimension as a Value Type dimension. E.g. for the case mentio-
ned above, with sales (in $), number of units, and costs (in $), the dimension 
chart may look like this:

Each component corresponds to one value column (cf. the columns NO, DS, and 
DC, in the above matrix). 
When HAT imports a file row with three different transaction values, it works as 
if it read the same file row three times over – one time for each value type. I.e 

Append at End Unknown components will be placed at 
the end of the chart, with HAT-Codes 
#00001, #00002 etc. The group will 
have the character # as HAT-Code, and 
New components as text. 

HAT-Code=Host Code A new component will be appended to 
the existing ones, and its HAT-Code 
will be identical to the Host Code.

After nearest Host Code The component will be positioned as 
the last element, in the group that has 
the closest Host Code of a higher rank.
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you have to define three different Line Fields: Line Fields 1, Line Fields 2, and 
Line Fields 3, one for each value type. The first is always present, so you have 
to create the two last ones with the command New Line Fields, to get the follo-
wing set of fields:

Only two entries differ in the three Line Fields – the positions of the fields con-
taining the transaction values, and its default component value. All the other 
entries have to be entered three times over.

To simplify this unnecessary tedious task, use the Duplicate Line Fields com-
mand. When the first Line Fields 1 entry has been completed, focus the Line 
Fields 1 menu, and choose Duplicate Line Fields 1 from the Edit menu, or 
simply press Ctrl+D. Then change the file row positions of the second value 
type, and also its default component. Repeat this procedure for Line Fields 3, 
and you will not only save time, but also minimize the risk of making mistakes. 

Import…
Will import either of

• a text file with transactions data; in this case an import setup window has to 
be active

• a complete HAT-file or sections of a HAT-file (e.g. the section containing 
only the analysis templates)

• a dimension chart or a time scale stored as a text file. 

Note that in order to import a dimension chart or a time scale, a window of any 
of these types has to be active. See page 49ff for Dimension Charts , and 
page 64ff for Time Scales

Export…
You can export an analysis result (table or chart) as a file. This menu command is 
functionally less versatile than the the corresponding function on the Export defi-
nition page, in each analysis template. See “Export” on page 88. 

You can also export the contents of an open and active dimension chart or time 
scales window. 

Exit
Will terminate the active HAT program. If the HAT database has been changed 
during the analysis session, you will get a warning message. 

MacOS
......................................................
......................................................The corresponding command is Quit
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Introduction
Many of the Edit menu elements in HAT are standard operating systems com-
mands. You are supposed to be familiar with them, and they will

not be explained further here. Some of the commands are specific for HAT and 
their names and functions will vary depending on the current state of HAT.

If a command is disabled, it of course has no function.

Commands in the Edit Menu
The commands look somewhat different depending on what element is focused. 
If a part of a text string is marked, the Cut command is changed to Cut Text, but 
if a selection is in focus, it is instead displayed as Cut Selection. In an analysis 
template you can see what element is in focus, either as highlighted text or as an 
element with a dotted border:

Note that you have to focus a field, to get access to the corresponding edit com-
mand.

Cut
Cut is equivalent to Copy followed by Erase. In Component Functions and 
Time Functions this command changes to Cut Selection or Cut Formula, when 
a selection or a formula is focused. If a local subset is in focus, the Cut com-
mand accordingly changes to Cut Subset. It is not possible to cut a variable in 
Component Functions or Time Functions, if the variable is used in a formula. 
Neither is it possible to cut the last selection from a template, as each template 
by default always has at least one selection. 
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Copy
Copy will change to Copy Text, Copy Selection, Copy Formula or Copy 
Subset with the same functionality as Cut, but it will not remove the original 
contents.

If the Variables pop-up is in focus in a Time Functions or Component Functions 
template, it changes to Copy Variables. You can then, collectively, paste all 
variables into a another multi-variable template. All the variable attributes are 
transferred to the new template – e.g. if one of the variables was not shown when 
it was copied, it will not be shown in the new context either. 

Note that local subset names are not copied, only global subset names. This is a 
natural consequence of the fact, that local subsets can only be referred to within 
the template for which it is defined. Global subsets, in contrast, are valid for all 
templates, i.e. they can also be copied and pasted between templates.

Copy Table.../Copy Chart...
Will copy a table (a list of results in an analysis) or a chart, depending on the pre-
sentation mode in the current analysis window. Copy Table/Chart is useful 
when you want to enter results from HAT into another application, e.g. Excel. It 
is often a convenient alternative to the Export option. Copy Table... can also be 
used to copy the contents in a dimension chart, or a user defined time scale.

Copy Table...
Every time you use the Copy Table... command you will get a dialog window: 

Copy Data. Allows you to specify what, and how much of the data you would 
like to copy.

Separators. You can determine how the copied fields are stored on the clip-
board. E.g. when you try to copy large numbers which have a separator to indi-
cate thousand positions, HAT uses the separator used by the Windows system, 
which is ”hard space”; but if these numbers are pasted into Excel, the hard space 
will make Excel interpret the whole number as a text string. By setting Thous-
and to None, you avoid this potential problem. 
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Copy Chart...
When you copy a chart from any type of analysis you will get a dialog window:

Copy Data. Select the part of the chart to be copied – All or Visible.

Chart Size. The picture of the chart will by default get the same size (in pixels) 
as the actual chart. You can reduce/enlarge the size of the copy by entering new 
values for Width and Height. But for the characters, the copy of the chart will 
change in proportion to the new values, unless the width or height values are to 
small to resolve the chart.

Paste
In a text entry box this command appear as Paste. You can also paste a selec-
tion, a formula or a subset with the commands Paste Selection, Paste For-
mula, or Paste Subset, depending on where the focus is. Paste Variables 
works in Time Functions and Component Functions, where it pastes a whole set 
of variables (selections and formulas) in one step.

Erase
When you mark a set of characters anywhere in a text entry box, this command 
will change to Erase Text. You can also erase a selection, a formula, a local sub-
set, or a component with the commands Erase Selection, Erase Formula, 
Erase Subset, or Erase Component, respectively. 

New
The functionality of this command also depends on the current context. New 
Selection and New Formula creates a new selection or formula in Time Func-
tions or Component Functions. New Component produces a new (empty) com-
ponent in a dimension chart. 

With New Subset a subset is added to the (possibly empty) list of local subsets 
(i.e. subsets defined ”within” an analysis template). Note that you have to focus 
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the entire frame around the list of local subsets, for this command to be available 
in the menu. A click anywhere in the list will achieve this:

But you can of course always click the button New Selection, to get the same 
effect in a simpler way.

Duplicate
Works with selections, formulas, line fields, and subsets. Duplicate Selection 
copies the selection which is in focus, and adds it to the list of selections. It will 
get the same contents as the one duplicated. Duplicate Formula and Duplicate 
Subset works in the same way

Select All
Works with fields containing texts. Highlights all the text in which the cursor is 
positioned.

Expand All
Expands all components in a dimension structure – in a dimension chart or an 
analysis template of types Components or Component Functions.

Set Column Widths
You can set column widths individually, either by dragging with the mouse or by 

double clicking with the column tool ( ) active, see section “Value fit and 
column width adjustment” on page 85.

If there are many columns to adjust, it is much easier to use this command, 
which give all columns in the current template, dimension chart, or other rele-
vant window, an optimized length. You can also use F6, as a shortcut.
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Introduction
The dimension concept is explained on an introductory level in Chapter 2: Gene-
ral about HAT. See “Dimensions” on page 8.

In this chapter you will find more details on exactly how a dimension is organi-
zed, how you can update it, make changes to it, etc. 

Basic Concepts
Components in a Dimension Chart

We use a chart of accounts to illustrate these concepts.

A chart of accounts usually has at least two types of elements

• account numbers, 

• account names, which describes what the account number is all about.

The accounts are often, but not always, ordered hierarchically in the host system. 
E.g. as in this example:

Labour costs consist of Payroll and Social security costs. Payroll costs, in turn, 
are split into Wages and Salaries; and Wages are split into Monthly wages and 
Piece-work rate, etc. 

In HAT these accounts typically constitute a Dimension chart, probably called 
”Accounts”. But there are many other examples of structures in different host 
systems that benefit from being represented as dimensions in HAT. E. g. pro-
ducts, customers, suppliers, projects, company units, employees, geographic 
areas – a list of such examples could be made very long. Each entry in a Dimen-
sion chart is generically called a component or dimension component, in HAT.

Name Code

Labour costs 50
Payroll 501
Wages 5011
Monthly wages 50111
Piece-work rate 50112
Salaries 5102
Social security 502
…etc… …
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HAT-Code, Text and Host Code
In a HAT dimension chart, the account name is found in the column Text, and 
the account code in the column Host Code. In addition to these, a HAT dimen-
sion component always has a HAT-Code:

The HAT-Code gives the user full flexibility to change the hierarchical structure 
of a dimension chart at any time. The HAT-Code is the only entry in a dimension 
chart that is mandatory – Text and Host Code are both optional. 

Properties

Click the Properties button to set the dimension names, how dimension compo-
nents are displayed, and how the fields are formatted when data are entered.

Names
The name of the dimension, in singular and plural forms.

The singular form will appear in all analyses, and the plural form in all other 
contexts. 
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Options for Analyses

Display in data fields. Dimension names are “labels” for the dimensions. 
They do not affect the data, but are displayed in menus, window name lists, ana-
lysis templates, Import Setups, etc.

Display in analyses data fields, lets you decide which codes and/or text that 
should be displayed for each component in the analyses. 

Example These examples span the whole range of possibilities to display a component 
with HAT-Code CVF, text FUELS, and host code 4010:

Must be filled in. Tick this entry if you want to enforce that at least one com-
ponent has to be entered in this dimension. If not, the template will not be calcu-
lated.

Example Use it when one dimension is Value Type, which has number of units and dollar 
values in it. If calculated without an entry in the corresponding dimension box, 
you would get the sums of number of units and dollar values. This is obviously 
meaningless, and can potentially give misleading results. 

Fields
Converts case settings in the database. When a HAT-Code, Text, or a Host 
Code is imported or entered, it will be converted as specified. You can also spe-
cify whether search in HAT-Codes will be case sensitive or not.

HAT-Code. 

Text and Host Code. 

The alternatives Standard and Word Caps are not valid for HAT-Codes. Space 
characters are not allowed in a HAT-Code.

Selection in pop-up menu Presentation in analyses

HAT-Code CVF

HostCode 4010

Text FUELS

HAT-Code Text CVF FUELS

HostCode Text 4010 FUELS

HAT-Code Host-Code CVF 4010

HAT-Code Host-Code Text CVF 4010 FUELS

UPPER CASE All characters will be uppercase

lower case All characters will be lowercase

Case Sensitive Search in HAT-Codes will be case sensitive

Case Insensitive Search in HAT-Codes will be case insensitive

Standard The first character will be uppercase

Word Caps The first character of each word will  be uppercase

Case Insensitive No conversion will take place
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Viewing a dimension chart
The Accounts dimension in Demo Inc serves as an example:

A dimension chart can be inspected by expanding any component into its sub-
components. The reverse operation is collapsing the subcomponents. To 
understand the status of each component you are guided by the hierarchy sym-
bols. Here illustrated by the small pop-up arrows to the left of the HAT-Code. 
You can choose between three different sets of symbols by setting the menu ele-
ment :

Hierarchy symbols
If the setting is without indentation, the hierarchy symbols are +, >, and space:

The arrow and explorer presentations are analogous:

Hierarchies without indentation

Arrow presentation

Explorer presentation

Presentation

Explanation
Without 
indentation Arrows Explorer

The component has sub-
components and can be 
expanded

The component has been 
expanded

This component is at the 
bottom of the hierarchy. 
It has no subcomponents 
and cannot be expanded
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Expanding a component with the mouse

A single click on the hierarchy symbol ( ) expands the component to the next 
level:

Another click on the symbol for expanded hierarchy ( ), collapses it again ( ).

Expand the entire dimension chart
Hold down the Ctrl key and select the dimension (e.g. Accounts) in the Dimen-
sions menu.

The command opens the dimension chart window (if it is not already open) and 
expands all components in the hierarchy.
Ctrl+2 (2 for the second dimension chart) achieves the same result.
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Expand all subcomponents 
 Double click on a component to expand all subcomponents. Other components 
are not affected.

Expanding/collapsing with the keyboard

Alt
Enter

The key equivalent of a single click is the Enter key. If the insertion point is loca-
ted in a collapsed component, the Enter key will expand the component. If the 
insertion point is located in an expanded component, the Enter key will collapse 
the component. Alt+Enter will expand all components.

Changing structures
An existing dimension chart can be modified in many ways, one of which is 
moving components from one position in the hierarchical structure to another.

Any subcomponents arranged under a component are moved along with this 
component.

Moving components with the mouse
You move a component simply by dragging it to a new position in the dimension 
chart. The following sequence shows how to drag a component to a parallel posi-
tion 

Note that the HAT-Code for the component is changed automatically.

Click on component,

Drag to the new position

Release the mouse button

and keep the button down
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You can also move a component ”horizontally”, to another hierarchical level. If 
you move the component slightly to the right, the horizontal arrow will be tilted 

( ). This is to show, that it will now be entered as a subcomponent.

The HAT-Code will be adjusted accordingly. 

Moving components with the keyboard

Ctrl+ Arrow up
Ctrl+ Arrow down

Moves a selected component up or down in the expanded region of the dimen-
sion chart.

Ctrl + Arrow left
Ctrl + Arrow right

Moves a selected component, to make it a subcomponent/parallel component to 
the one on the line above.

Adding components
Sometimes, you may want to define a new component, e.g. to define a new group 
of subcomponents.

There are several ways to add components:

1. Adding components by editing.
The New component command in the Edit menu inserts an empty line in 
the dimension chart. HAT will suggest a code. Duplicate codes are not per-
mitted.
The keyboard equivalent for New Component is the Return key. 

2. Adding components by importation. 
If you want to add many components, it is often more convenient to use the 
Import command. The imported table may be created in a word processor, 
spreadsheet application, or produced directly from your host system. 

3. Coding of new components.
Often, a hierarchical structure of a dimension will be provided by the host 
system. You can restructure the dimension chart in HAT and create new 
“branches”. The HAT code you enter for new components should be as short 
and simple as possible. When you subsequently move the component to its 
place in the hierarchy, HAT will suggest a longer code which reflects its posi-
tion in the hierarchical structure.

Example The new account, Travel grants, is given the preliminary code T. When it is 
moved to CLO Other empl expenses, it will be given the new code CLOT 
Travel grants.

Deleting components
You can delete a component from the dimension chart only if it is not currently 
active, i.e. if there are no Lines in the database which use the component or any 
of its subcomponents.

When a component is deleted, all of its subcomponents will be deleted as well.
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There are two ways to delete components:

1. The Clear Component command in the Edit menu deletes the component at 
the insertion point. The corresponding keyboard command is Ctrl+B.

2. You can delete all components which are not currently active, used, or all of 
them, by saving the HAT database to a file with the Save Special command. 
With the options Active, Used, or None selected. 
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Introduction
This chapter describes how you can make changes to a HAT database. We add 
Cards, delete them, or transform them. Note that we always, conceptually, make 
a clear distinction between the HAT database (which reside in the internal 
memory, the RAM), and the corresponding HAT-file (which is stored on a secon-
dary medium, usually a hard disk). All the changes described here only affects 
the HAT database. Not until the HAT database is saved, the changes updates the 
more permanent HAT-file.

New Card
The New Card command opens a window for creating a new Card. Use it 
when you want to add data to your HAT database.

See page 7, for a picture of the ”anatomy” of a Card. 
The rules for editing in a new Card also apply to existing Cards.

You can edit a new Card by using the techniques listed below. The Created and 
Modified fields are filled in automatically when you close the Card window.

Editing a Card

Header and footer edit boxes

Card ID

The default Card ID of a new Card, is today's date plus an ordinal number.

If you change the date, a correct ordinal number will be provided automatically.  
The new Card ID will be shown in the title bar of the Card window the next time 
you open it.

Card Title and Notes

Contains any text, up to 1023 characters long. You edit it in the same way as any 
other textstring.
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Fields in the Card body
The borders of the data fields in the Card body are not explicitely displayed on 
the screen, but the fields have their defined positions (according to the column 
headers) and are editable.

You can move the insertion point between the data fields in a Card with the Tab 
key. Use Shift+Tab to go backwards.

Create a new Line by pressing the Enter or Return keys.

If you want to enter a component from Dimension 1 (e.g. A Actuals for Demo 
Inc), you can indent the Line with Shift+Tab, or by clicking with the mouse in 
the appropriate position.

Dimension components. To enter a dimension component, you can use the 
keyboard to enter its HAT-Code, Text-part, or Host Code. 

You can also get access to the whole dimension chart, by using double-click or 
Ctrl-click in the dimension field. 

Release the Ctrl-key before you release the mouse button, to actually enter the 
highlighted component.

Choose between mouse control and keyboard control exactly as in dimension 
boxes in analyses. See section “Selection Boxes - Dimensions” on page 75.

It is easy to change the order of the Lines in a Card. Simply drag the selected 
Line to the desired position by point-and-hold down-click in the left margin of 
the Line.

You can also move Lines and Groups with Ctrl-Up Arrow or Ctrl-Down Arrow. 

Double-click 
or Ctrl-click
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Value field entries
Several arithmetic functions can be used in the value field of a Card, to simplify 
the entry of values:

An arithmetic expression can also include one of the special operators. 

MacOS
......................................................
......................................................Instead of sum, the symbol ∑ can be used. 

Delete Card
The command Delete Card only works if there is a Card window currently 
active.

When you select the command, the entire Card is deleted from the HAT data-
base. The deletion is not made permanent in a HAT-file until you Save the data-
base.

Examine,  Approve
The data in the Examined and Approved fields are often imported into the data-
base together with the rest of the data on the Card.

By using the commands Examine and Approve in the menu, you can enter data 
in these fields from HAT. This can be useful in various situations, such as audit-
ing.

Example

Function Symbols
Entered in 
field

Result when you 
leave the field Spelled out

Copy from 
previous

prev or "
10 000

"

10 000

10 000
Enter same value as above

Total sum

10 000

15 000

sum

10 000

15 000

25 000

Sum of all preceding fields 
in the same Group

Balance bal or =

- 10 000

25 000

=

- 10 000

25 000

15 000

Balanced sum, i.e. sum of 
all Lines in the Group

with reversed sign

Calculate +, -, etc 120*0,2 24 Result of the expression
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Both commands work in the same way. When you select the command, the date, 
time, and current signature are registered in the Examined or Approved field on 
the currently open Card.

Signature. If you have not defined a signature using the Signature command, 
HAT will ask you to do so the first time you use Examine or Approve.

HAT requires a signature, and enters it in the appropriate Card(s), when you 
select any of the following commands:

This is also the case when you close a Card which you have changed.

You define a signature by entering 1-3 characters (letters and/or digits) in the 
dialog box. You can use uppercase and lowercase letters to distinguish signatu-
res, i.e. BEM is not the same signature as Bem.

The entered signature is in effect as long as the database remains open. It is not 
saved with the HAT file (except in the signed Cards).

Do not confuse the signature with the password, which is required for access to a 
protected database.

Transform…

Introduction
The Transform command lets you to change a part of, or all, data in a HAT data-
base.

A similar command is Add which adds new, transformed, data to the original 
database.

These commands are useful in e.g. 

• Prognoses based on actual outcomes

• Budgeting

• Simulation

• Project planning and follow-up

• Index adjustments

• Exchange rate adjustments

• Consolidation

• etc

Data affected by transform
To transform a set of data, you first make a selection in one of the templates. We 
call this the active selection. Then, when you press the Transform button, all the 
data in the active selection will be affected.

New Card
Examine
Approve
Transform…
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I.e. the Transform command transformes the following data:

• All the Lines defined by the selection in a Lines template. 

• All Lines similarly defined in a Cards template. Note that only some parts of 
the Card data may be affected, depending on the selections made in the 
Groups and Lines pop-up menus in the Cards template.

• If the database window is active, it represents the whole database, i.e. all the 
Cards and all the Lines.

E.g. a transformation will affect all the data. Use with care!

• An individual Card in active, editible, mode.

Add generates new data. With the command Transform, the existing 
data are changed. In all cases but one, you have an alternative option – 
Add. It generates new data from the current ones, and adds them to the 
HAT database. The exception is the single, editible, Card, which can only 
be transformed. To add a new Card, based on an old one, make the Card 
active. Enter the desired changes by normal editing operations, and close 
the Card window. You will then get a dialog window, with the option to 
Add it, as a new Card, to the database.

Transform operations
The transform window has a number of entries allowing you to change all or part 
of the fields in the active selection:
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Replace current dimensions with. Actually this is a short form of the sen-
tence ”Replace current dimension component with”. If you specify a component 
in a dimension box, 

the new component will be assigned to all Lines in the active selection.

Example You want to simulate the result for next year on the basis of the current year's 
actual figures. You keep all actuals exactly as they are, but tag the transformed 
numbers as budget figures for the next year.

Card ID. Replace the current Start Card ID with a new starting point:

960701 will be replaced by 970701 in the new Lines set. All other Lines in the 
active selection will also be offset exactly one year forward. This is so, because 
the right End box was left empty. In this case the new End value is implicitely 
assumed to be moved exactly parallel in time, with the Start value. Had we ins-
tead entered a value, say 970401, in the last End box 

all the Lines in the left Start-End interval would be proportionally spread over 
the new (in this case smaller) time interval:

Card Title, Line Text, Notes. Transformation of text in these fields works in a 
similar way. Basically the function is the same as Search and Replace in a word 
processor.

Example With the following entries

all empty Line Text fields will get the text ’check!’ in them.

Every occurrence of the text string you enter in the left box will be replaced with 
the text you enter in the right box. The search text is not case sensitive, but the 

960701 970701

970401
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replace text will be entered exactly as it is entered in the replace box. The follo-
wing operators are available in the search box:

Value. You can enter a formula in the value box to define new values in the 
Lines. The current values are represented by “A” in the formula (default entry in 
the box). The formula can contain any arithmetic function allowed in HAT.

Enter arithmetic operators either from the keyboard or by clicking on the pop-up 
arrow in the Value box. 

Example You want all values in the selection to be reduced by 13.5%.

This can be used e.g. to simulate a cost reduction in a forecast.

Signature. When you select the Transform or Add command, HAT requests 
a signature which will be used for the new Cards. Any signatures in the Exami-
ned and Approved fields are removed, and the Modified field is filled with the 
date and the signature for the transformation.

Splitting Cards during transformation
If the information on the Card level (Card ID, Card Title, or Notes) is unchan-
ged by a transformation, all Lines are retained within the same Card.

But if a transformation affects only some of the Lines on the Card, the transfor-
mation generates two Cards. One contains the transformed Lines with new Card 
information, while the other retains the “original” Card information and the 
Lines that were not transformed. The date in the Created field is set to the date 
of the transformation.

Some potential effects of a transformation. 

If you transform accounting vouchers, some Lines may be transformed, but not 
others. This can result in vouchers that no longer balance.

Transformations that lead to displacement in time can also result in Lines being 
spread over several Cards, although they originally were on the same Card.

Delete Data
The Delete Data command deletes data from the database. The data to be dele-
ted are determined in the same way as for the Transform command.

Operator Meaning
<    Before The new text will be appended before 

the current text

>    After The new text will be appended after 
the current text

\     Empty All empty text strings will be replaced 
by the new text

¬\  Non-empty Any text string will be replaced by the 
new text
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Subsets
Usually you will use the entry fields on a Selection definition page of a temp-
late, to define a selection. 

But occasionally you want to achieve what you aim for in a somewhat simpler 
and more straightforward way. E.g. if you use a certain selection over and over 
again, you would probably prefer to be able to define it once and for all.

Or you want more advanced selections than allowed on a Selection definition 
page. E.g. combine a number of different selections to define one combined sub-
set. 

For these purposes you have two types of subsets available:

• Global Subsets, i.e. subsets that are ”globally” available, to be used in vari-
ous templates, and other contexts.

• Local Subsets, which are defined for a certain template, only.
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From all other aspects, the two types are equivalent. In this section we will only 
cover the generally available Global Subsets.  With the command New Subset 

you will get an empty selection to fill in:

Ordinary selections vs Subsets
Compared to what is available in the selection entries of an analysis template, 
you can:

Combine many selections. You can define a number of independent selec-
tions, not just one. By clicking on the A menu button (in the case above) you will 
be able to enter another selection (New Selection) which will get the default 
name B. By repeating this operation a number of times, you get selections A, B, 
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C, D, ... Their individual names can be changed to more descriptive ones, if desi-
red. Do this by entering a new name in the text field to the right of the menu but-
ton.

You can then combine these independent selections to make more complex ones, 
by writing a logical expression using the individual selections already defined, 
e.g

A & B | C

which means the set of Lines in both selections A and B, combined with the 
Lines in selection C.

Use more fields in the selection criteria. Each definition page has more 
fields available for defining selections, e.g. the fields Time and Signature.

Cards and Groups operators
In the box Combination you can enter any logical expression, as mentioned 
above. But two new operators are specific for subsets: 

• Cards, and 

• Groups 

If you have made a selection A by entering a number of criteria, this in effect 
selects the Lines that meet these criteria. But you may want to select all Lines in 
a Card, which contains at least one Line that meets the criteria. By entering

cards A

in the Combination box, you will get exactly this.

The groups operators is analogous, with the obvious difference that you instead 
get all Lines of the selected Group. 

Example In the Demo Inc database there are Cards with different kinds of VAT entries, in 
the Account dimension. These entries typically go in pairs; it should not be only 
one VAT entry in a Card. To check this, we define a subset with two variables, A 
and B:

and

HAT enters the default combined expression A|B, which you easily can change.

We change the expression to
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and press the Calc button. We change the default name G2 of the new subset, to 
the name 

VAT vouchers

which will turn up in the menu

In this case the operator cards was entered from the keyboard. Often it is simp-
ler to enter it from the operator menu. You activate this menu by clicking at the 
pop-up arrow in the box Combination. Click with the F1-key pressed or right-
click with the mouse, and you will get the list:

The corresponding keyboard command is Ctrl-F1-Arrow.

MacOS
......................................................
Use the Alt-button to activate this menu with the mouse.

......................................................The keyboard command is Command-Alt-Arrow.

As soon as the first subset window has been activated, every analysis template 
will get another entry box, Subset, added after the Value box:

In this box you can enter the name of the subset by typing its name from the key-
board, or by using the pop-up arrow

Note that it is not possible to make the same selection, without using a subset, in 
e.g. a Cards analysis template. It is possible to select all Cards that has at least 
one of the account entries ’2410 VAT ’ or ’3011 N.I.S. - VAT 100%’, by entering 
the expression LCV2410 | RF3011 in the Account dimension box. But if you 
would try with the expression 

LCV2410 & RF3011

no Cards (or Lines) would be selected at all. The reason is that you always spe-
cify Line attributes in the analysis templates selection boxes, and a Line cannot 
have two different codes from the same dimension, of course. 
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You can enter and delete subsets with the commands in the submenues:

You install a new template, or change an already installed template, by closing 
its window. Then make your choice in the dialog window:

Time Scales
HAT has a number of built-in time scales, which are used in the Time Functions 
templates. But you also have the option to create you own customized time sca-
les. This is very useful when the usual calendar time scale does not fill your 
needs. E.g. if you are working with financial periods specific for your company. 
Similarly, semesters could be more relevant for schools and universities, than the 
usual calendar time.

New Time Scale. Will produce an empty window

• Enter the name of the time scale.

• Enter the start of each period in the scale.

YY  (97 will return 970101-001)

YYMM (9702 will return 970201-001)

YYMMDD (970205 will return 970205-001)

• Enter the name of the period.
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The end of a period is defined automatically as the last Card before the start 
of the next period.

• Enter the start of next period, and so on.…

If you want the period to end before the last Card, you can define a dummy buf-
fer period to force a period to end in the right place.

The time scale is entered into the HAT database, when you close the window. 

Importation to a Time Scales window. Instead of entering the time scale 
elements via the keyboard, you can import a textfile with two columns (i.e. the 
fields are separated by Tab) to an active Time Scales window. This can be done 
in either of two ways:

• Using the Import command in the File menu. A Time Scales window has to 
be open and active. The Import command then changes to Import Time 
Scales…, and you get the usual dialog window for opening the textfile.

• Drag-and-drop. Drag the textfile icon into the Time Scales window, and the 
textfile will be imported

Macros
With HAT Macros you can instruct HAT to do a series of operations automati-
cally. At its current stage the set of instructions is designed with an emphasis on 
simplifying the operations to produce HAT-applications from ground up, often in 
large numbers to be distributed to other users. I.e. the typical tasks of someone 
who has an Operator- or Server-processor attached to the computer. If you do a 
long sequence of operations over and over again, e.g. produce 50 different HAT-
files for different users, you may benefit a lot from writing HAT Macros to per-
form these operations automatically. Together with the OLE support built into 
HAT, you can build astonishingly simple, fast, and fully automatic solutions, that 
produces large number of HAT-files and distributes them to the users. 
Also, if you are preparing an HAT application for use by someone who is a 
novice at HAT, you can install HAT Macros that do the complicated operations, 
Thus requiring a minimum of knowledge on how to operate HAT. 

You can also perform the equivalent of a series of macro instructions by 
importing a special segment of a HAT-Text file. This segment is called Com-
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mands section. See the document HAT-TEXT File format 4.1, for a technical des-
ciption of the HAT-Text file format in general, and the Commands section in 
particular.

Because it is primarily intended to be used by skilled “technical people” this 
material is of a rather technical nature. If you just use HAT for regular analyses, 
you can safely skip these parts of the manual. Almost everything you can do with 
macros, you can also do by interacting with your HAT application in the usual 
way. And in a much easier way – this is the very purpose of the HAT user inter-
face. 

The following description gives you a brief overview of Macros and the Com-
mands section. To get the details, consult the special documents on these matters.

Creating macros

With the command New Macro, you get an empty window:

Name. If you want to install a macro in the HAT database, you have to give it a 
name.

Steps. A HAT Macro script consists of a number of steps, one step on each line. 
A step corresponds to one general command, usually with information on what 
object this command should operate on, and sometimes with some further speci-
fications on what to do.
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Example A typical case is when we want to update an existing HAT Database with new 
data. With a suitable macro, all the working steps can will be done quickly and 
with a minimum risk of mistakes:

A few comments to the script:

• Double slashes (//) are used to indicate that the text that follows, on the same 
line, is a comment, which plays no active part in the execution of the macro. 
It is “dead text” with the only purpose to clarify what the macro does. It is a 
good practice to use a lot of comments in macros.

• DeleteCards is a macro command, which deletes all Cards in the current 
database. This command also has the option to delete only a part of the data-
base. 

• the ErrorFile-command is further specified by telling that a text-file with the 
name Errors.xls will be created. It is wise to always include this command 
when macros are used to import files. Potential error-messages will be stored 
without interupting the importation process; otherwise error messages will 
show on the screen, requiring user interaction to be able to continue. 

• Two files are imported, each one using its own import format, which is indi-
cated with the last words e.g. -s “Actuals format”. The -s part tells HAT to 
use a Save Setup, and the “Actuals format” tells HAT which format to use. 
We have to place double quotes around the text Actuals format because it has 
a space character in it. The space character is used as a word and command 
separator in a HAT Macro script, but with the quotes, the text Actual format 
will be interpreted as one entity.

• After the HAT-file has been saved, using the setup Save Setup 5, the HAT 
Database is closed.

Show in Execute Menu. If a macro is the first one for which you choose this 
option, a new menu element, Execute, will be created (positioned between the 
Analysis and Window menu elements), with this macro in it. If the menu 
already exists, it will simply be added to the list. 
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Password required for this window. A macro may contain information 
you want to keep from general display. Especially if the macro itself contains 
passwords to other files. By ticking this option, you cannot open the macro script 
without providing the same password you need to open the file itself.

Database Info
To get a more detailed picture of different aspects of the database and its con-
tents, use the command Database Info. You get exactly the same information if 
you click on the HAT file symbol in the database window. For a full explanation 
of the contents see “Information in the database window” on page 16.

Database Settings...
These settings can be customised for each database and is saved with the HAT-
file.

Cards

Card ID. Defines the number of digits in the Card ordinal number that follows 
the date number.

This setting is automatically adjusted by HAT to comply with the contents of the 
database, but in some cases you may want to show more digits than necessary. 

Decimals. Defines the default number of decimals displayed in Cards

Reference point
Gives the position for a vertical Line (which is red, on a color display – other-
wise black) in templates that show data by time, in graphic mode. The Line can 
e.g. mark a date of special interest.

It also acts as a common reference point in time. You can refer to it e.g. in temp-
lates you have installed – to be used as a ”global” variable. It is named Refe-
rence. By changing the value of the reference Card ID, the contents of all these 
templates will change accordingly.
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Alternative Titles
You can change some of the field names used in the HAT templates.

In this case the default text Card Title is changed to Voucher, and Value to 
Amount.

Signature…
You can change the signature which is entered automatically by HAT with this 
command. Signatures has already been described earlier in this chapter. See sec-
tion “Signature” on page 55.
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Introduction
The Analysis templates are at the very heart of HAT.  You use them to get a max-
imum of information from your HAT database.

This chapter gives a very brief overview of the different analysis template types. 
A full description of the other elements in the Analysis menu, follow in separate 
chapters.

Cards
The Cards template is primarily used for inspection of chronological lists of the 
Cards in the database, either the complete contents or selected parts of the con-
tents. 

Lines
In the Lines template you select certain Lines from the database. The selected 
values are listed by transaction in chronological order. The separate transaction 
values and/or the accumulated values are displayed. It can also be presented 
graphically. A number of summary values for the whole set of values can be cal-
culated, based on the selection: number of Lines, maximum and minimum 
values, turnover time, accrued interest at different rates, etc

Components
Components calculates and presents a subset of data as a function of a dimen-
sion. You can easily change between many views/dimensions. The result can be 
displayed as a numerical table, or as a pie charts.

Time Functions
Time functions calculates and presents data as functions of time. In a way it is a 
much more advanced version of the Lines template. You typically add values by 
period, e.g. costs per month. Or accumulate these values over time, e.g. costs 
accumulated over time. You are free to set the level of aggregation, by using dif-
ferent time resolutions – from the very detailed view of showing each single 
transaction (equivalent to Lines, above) to showing aggregates by day, by week 
etc, up to yearly figures. You can also define your own time scales. 
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But the most significant aspect is that you can define any number of variables 
and formulas in Time Functions. E.g. to calculate deviations from budget, key 
ratios, and a lot more. The results can be presented graphically or numerically.

Component Functions
If Time Functions is the more advanced version of Lines, the Component Func-
tions template is the advanced analogy of Components. You work with selection 
variables and formulas, to calculate budget deviances, ratios, and many other 
measures of you own choice. Instead of presenting the results by time, you get 
them by component. The results can be listed or displayed graphically.

Set Defaults
When you open any of the five different templates, you get some default settings. 
The very first time, these are set by the system. But you can change them at any 
time, to suit your needs better. 

If you have a template in an active window with certain settings, and activate the 
Set Defaults command, all these settings will appear the next time you open a 
new template of this kind. Window size, entries in the dimension boxes, etc – 
they all turn up in the new template. 

Install Template
If you have defined an analysis template, you may want to store it as a ”standard 
report”, to be available at any time in the future. Install Template allows you to 
do that.

If you have a template in an active window, and activate this command, you get 
the following dialog window:
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Template Name. The template can be given any name, consisting of alfanu-
merical characters. Often you prefer to put them in logical groups, e. g. all finan-
cial reports under the heading ”Financials”. You achieve this by using the colon 
character (:) between the intended group levels. E.g.

will create the group Financials, which has the the subtemplate Liquid assets 
in it. If we later install a template with the name Financials: Loans, it will turn 
up in the same group.

Open Directly. The template will be automatically displayed when you open 
the HAT database. Use it for templates you should never forget to look at, temp-
lates used as reminders of ”things to do”, or to convey a message to a collegue 
who will work with the HAT-file, etc.

Calculate Directly. If this box is not marked, you will have to press the Calc 
button, to get the final report. This is usually ticked, but it may happen that the 
selection in the template will always be somewhat changed before it is calcula-
ted. If the database is very large, you may prefer to postpone a time consuming 
calculation until the result is relevant.

Zoom Directly. The template will be zoomed directly when activated.

Fixed Position. The template will, when opened, be positioned on the screen 
exactly as when it was installed.

Add. If you make any changes to an already installed template, and click on the 
Install button, the template will be changed. If you want to install the new ver-
sion, and keep the old one as before, you should change the name of the temp-
late, and click the Add button.

Remove Template
Remove Template lets you delete an active installed template. A dialog win-
dow will be displayed, giving you a last chance to change your mind.
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Introduction

The Analysis template
The five template types differ in their layout, but some parts are almost identical. 
The following picture shows how it typically looks, with the most prominent 
definition page (Selection) active:

Definition page menu
Each type of analysis template has a number of different definition pages, where 
you can define what data you would like to see, and how they are presented. Use 
this menu to switch between different definition pages.

The Calc button
When the button is highlighted you have to press it in order to get the correct 
output, i.e. corresponds to the entries you have done on the definition pages.

Selection boxesDefinition page
Definition page 
menu

Input
area

Output
area

Output header

Pop-up arrow
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Selections

Selection Boxes - Dimensions

Entering single components
There are several tools available for defining selection criteria in a dimension 
box, e.g. Account. You can use:

• Arrow pop-up menus with mouse control

• Arrow pop-up menus with keyboard control

• Text entry from the keyboard

Selecting with mouse control. By pressing the mouse button on the small 
arrow to the right in the dimension box, e. g. Accounts, the highest level of 
account groups will pop up. When you move the cursor to a lower level in the 
account structure, it will successively unfold. The hierarchical menu has the 
same structure as the dimension chart:

When you release the button, the highlighted component will be inserted in the 
box. At first, only the HAT-Code of the component will be displayed, but as soon 
as you move the curser elsewhere, also the component text will show up. If you 
enter an expression with more than one element, e.g. COSTS or REVENUES, 
only the HAT-Codes will be displayed, to save space.

Selecting with keyboard control. You can use the keyboard to unfold the 
dimension chart and get the same result: 

1. Place the cursor in the dimension box.

2. Press the Ctrl-key and one of the up or down arrow keys.
The first level of the hierarchical menu will show up.

3. By pressing the arrow keys you can ”wander around” in the tree.

4. When the appropriate component is highlighted, press Enter, and the HAT-
Code of this component will be filled in.

Text entry from the keyboard. If you enter a character string in a dimension 
box, HAT will search for a matching string in the corresponding dimension 
chart, in the following order:

1. Search in HAT-Code. 
The search is performed using only the characters before the first space in the 
entered string. Matching is sensitive to the character case when the field pro-
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perty is set to Case Sensitive, in the Properties setting of the dimension 
chart. This search returns the component giving an exact match of the HAT-
Code. If no such match exists, the search continues among the Host Codes.

2. Search in Host Code. The search uses all the characters, including spaces, of 
the entered string. Matching is sensitive to the character case when the field 
property is set to Case Sensitive, in the Properties setting of the dimension 
chart This search returns the component which matches the entered charac-
ters at the beginning of the Host Code. If there are several alternatives, the 
one with the closest match is returned.

3. Search in the Text field, finally, is done in two phases:
First, the search is performed using the characters following the first space in 
the entered string.
Second, if phase 1 fails, the search is repeated using all characters in the ente-
red string.
The matching is always Case Insensitive.

Node Finder. If all these types of search fail, a dialog box (the Node Finder), 
will appear: 

You can then enter a code, either by using the arrow pop-op menu, or by entering 
a text in the field. You see exactly how HAT interprets the text you enter, 
immediately to the right in the dimension box:

Click the OK button when the intended component shows up.

Entering component expressions, using operators
With operators you can form expessions that combine or exclude components in 
a dimension box. The operators are available in an arrow pop-up menu, or can be 
entered directly from the keyboard.
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To expose the operator menu, place the cursor on the pop-up arrow and press the 
right mouse button, or press the F1 key while simultaneously pressing the left 
mouse button: 

Release the button on the element you want to enter.

MacOS
......................................................
To get the corresponding function on Macintosh, press the Alt-key while clicking 

......................................................on the pop-up arrow.
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The component operators

Combining component sets with operators
You can combine several operators and sets. Use parentheses to ensure the cor-
rect priority in evaluating a combination. As usual, the expressions within paren-
theses are evaluated first.

Example: C¬(CL|CD) selects accounts belonging to C COSTS, but not CL LABOR 
COSTS or CD DEPRECIATION

Feed back
Every expression you try to enter in a selection box will be interpreted by HAT. 
The interpretation will be explicated in the box as soon as you

• Leave the box

Sym
bol Name

Other 
names Example Explanation

| Union or C|R All Lines in the two 
sets, C and R, together

& Intersection and C&R All Lines common to 
the sets C and R 

± Either-or exclusive 
or

C±R All Lines in either of 
the two sets, but not in 
both

¬ Complement not ¬C All Lines not in the set 
C

( Open Left parenthesis

) Close Right parenthesis

\ Null empty, 
void

\ All Lines that have no 
entry at all (in this field)

! Highest 
Component

C! All Lines coded with 
exactly C, i.e. excluding 
subcomponents

? Intermedi-
ate Comp-
nents

C? All Lines coded with 
subcomponents to C, 
but not C itself or sub-
components at the 
lowest level

¶ Lowest 
Components

C¶ All Lines coded with 
lowest level subcompo-
nents to C

^ Upward 
Path

C^ All Lines coded with C, 
or components above C

_ Interval CLW_CD All Lines coded with 
CLW or CD, or compo-
nents between these in 
the dimension chart
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 file

-

• Press the Enter button

• Press the Calc button

Selection Boxes - Time
The time span for the the selected Cards or Lines is set in the boxes:

Default time limits. Default time limits are the first and last Cards in the file, 
unless otherwise specified with the Set defaults command.

Editing time limits
You can change the time limits by editing the Card IDs in the boxes. You do not 
always have to enter all digits. HAT completes partial entries in accordance with 
the examples below:

From box. HAT completes partial entries by inserting the earliest possible 
value:

Example: 94 is completed as 940101-001.

9401 is completed as 940101-001.

940101 is completed as 940101-001.

To box. HAT completes partial entries by inserting the latest possible value:

Example: 96 is completed as 961231-999.

9606 is completed as 960630-999.

960630 is completed as 960630-999.

The time operators
By intelligent use of time operators to define period limits, you can gain some 
advantages:

• Easier to enter dates which you may not know in advance.

• Allow “dynamic definitions” of analysis templates.

HAT is rather forgiving when interpreting what you enter in a time box. E.g. if 
you enter f, fi, or files in a time box, HAT interprets them all as File.

The examples in this table assumes that ”today” is July 1st 1997:

Short 
name Full name

Enter the short name, and HAT will enter

Explanationin From box in To box

f File 970101-001 File 970101-999 File Beginning and End of

r Reference 970401-001 Reference 970401-001 Reference As set in Database Set
tings
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Time offsets
For the operators refering to the current time period (day, week, etc), you also 
have the option to set the time back or forth, by entering a signed numeral in 
addition to the operator. E.g. if the current date is July 1st 1998, you will get 
the following effects: 

Using your own Time Scales
If you have defined a Time Scale (in the Database menu), you can use its con-
stituent time periods in a similar way as the time operators. If the time scale is 
Financial Months (see below),

you can refer to these period names.
E.g. if you enter ’sept’ in the From time box, you get 

See section “Time Scales” on page 63, for more details on how to create your 
own Time Scales.

y Year 970101-001 Year 970101-999 Year Current year

m Month 970701-001 Month 970701-999 Month Current month

w Week 970630-001 Week 970706-999 Week Current week

d Day 970701-001 Day 970701-999 Day Current day

Short 
name Full name

Enter the short name, and HAT will enter

Explanationin From box in To box

Expression
HAT 
Interpretation

Entered in 
From box

Entered in
In To box

d-1 Yesterday 980630-001 Day-1 980630-999 Day-1

w+1 Next week 980701-001 Week+1 980713-999 Week+1

m-1 Last month 980601-001 Month-1 980630-999 Month-1

y-1 Last year 970101-001 Year-1 971231-999 Year-1
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Selection Boxes – Text
Text search in HAT is very fast and flexible. It allows you to search for a specific 
Card or ”filter out” e.g. all Card texts that has a certain supplier name or number 
in it. In this way it, in a sense, works in the same way as a ”search” for a compo-
nent in a dimension chart. The option to define very complex searches also has a 
certain price, in terms of making it somewhat more difficult to use. In order to 
make life as easy as possible, without sacrificing the sophisticated functionality 
in cases where it is needed, text search in HAT is split in two levels - simple text 
search and advanced text search. 

Both kinds of text search applies to the Card Title and Line Text boxes.

If you simply enter any string of text, it will by default be conceived as part of a 
simple text search. This is probably by far the most frequent way of using text 
search. When simple text search does not do the job, you invoke advanced text 
search by starting the search string with the \-character.

Simple search texts
If you enter a string of characters in a text box (Card Title or Line Text), and 
press the Calc button, HAT will select all entries that contain the entered text-
string anywhere in the target text. The search is not case-sensitive, i.e. the search 
strings ’shop’, ’SHOP’, or ’shOP’ will all define the same selection. Each will, 
by itself, find the strings ’Barber Shop’ and ’bishop’. All characters are allowed 
in a simple search text, with a few exceptions – the logical operators |, ±, &, ¬, 
and the parentheses ( ) have a special status, for the very reason that they are 
logical operators and parantheses. Also, the backslash character (\) is reserved to 
indicate advanced text search, so it should not be used as a leading character, 
either. 
By combining simple search texts with logical operators, you get logical expres-
sions that implement somewhat more advanced forms of simple text searches. 

Example If you enter the string 

(bar&ho)|bi

in a text selection box, the strings ’Barber Shop’ and ’Bishop’ will both be 
found.

The logical operators basically have the same meaning, as in other parts of HAT. 

Advanced search texts
Sometimes more complex searches are required. E.g. you want a selection based 
on exactly the string ”Ltd”, in order to select all companies of this type. To get 
maximum precision you want the first letter to be a capital L. But in simple 
search texts, the difference between capital and small letters is not significant. 
You have to use advanced search texts.

In this example the search text would look like this:

\^Ltd

The ^-character just before the L, means that exactly this letter (not the others) 
has to be a capital letter.
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The \-character acts as flag, telling HAT that the characters that follow should be 
regarded as an advanced search string. The following characters will, when 
occurring after the back-slash sign, get a special meaning:

Observe that in advanced search texts:

• capital and small letters are equivalent, if not explicitely stated otherwise 
(using the ^-character), just as in simple search texts

• HAT searches for exactly the string stated (but for being case insensitive). 
E.g. \Ab will find AB, and aB, but not ABC.
The simple search text 

ab

and the advanced search text

\*ab*

are equivalent, i.e. they will both find ab, aB, Ab, or AB anywhere in the 
text.

Logical operators
Search texts can be combined by logical operators to form more complex search 
expressions. The operators

|, &, ±, and¬

all have their usual meaning. 

Example The search expression

bus | nav

Sym
bol Meaning Example Will find ... Will not find ...

* any textstring \*age storage, CAGE ageing, cages

? any (single) character \?wan swan, Ewan Taiwan, wanted

^ case (capital/small 
letter) is significant

^Ltd Ltd, LTD ltd, lTD

{ } groups many charac-
ters

^{Ltd} Ltd LTD, ltd, lTD

; separates strings, of 
which at least one 
must match

\lon*;*ful lonely, joyful alone, fullfilment

: after characters that 
occur consecutively, 
zero or many times

\a:bc BC, abc, aaabc abb, abcc

+ after characters that 
occur consecutively, 
one or many times

\a+bc abc, aabc, AaABc BC

_ interval \a{b_f}c aCc, AfC akc, ABF

’ ’ enclosed characters 
are pure text

\’a{b}’ a{b}, A{b} ab, AB

” ” enclosed characters 
are pure text

\”a’b’c” a’b’c, a’B’C abc, a´bc
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will find text strings with any of the two strings ’Business’ and ’Navigator’ in 
them.

A search text that is preceded by backslash (\), is interpreted as an advanced 
search text, up to the first logical operator. Thus, it is possible to mix simple and 
advanced search texts, to a full search expression. 

Example The expression

\*^{Ltd}&hop

will find Shoplifters Ltd or CHOP CHING Ltd, but not Grasshopper LTD.

Selection Box – Value
You can select Lines to be analysed based on numerical values, by entering 
search criteria in the Value box

Example If you enter 768, the Lines with the exact value 768 will be selected.

You can use the usual logical operators to form a search expression. The logical 
operators need no further explanation – they work as you expect from their other 
uses in HAT (see the description of Component operators). Also the interval- and 
the parantheses-symbols can be used. The relational symbols (<, >, =) can be 
used as single symbols, or in combination. 

As always, HAT exposes its interpretation of what you enter, e.g. if you enter the 
string ’> < 56’, HAT responds by changing it to ’<>56’, as soon as you leave the 
value box, or press the Calc button.

Example

Table and Chart views
The basic purpose with HAT is to allow the HAT user to exploit the potential 
information content in a database, easily and efficiently. This also requires that it 
should be easy to present the results in an optimal way. In one case you want 
details, e.g. check that the accounts balance, not just roughly, but to the last cent. 
In other cases you are best served by a broad overview, e.g. yearly sales by pro-
duct, rounded to nearest thousand, and presented graphically.

Among the different ways to present data in a meaningful way, the most basic 
distinction is between

• Table view, i.e. presenting the results in tables, or lists of values

• Chart view, using graphics instead

566 | 568 will find all Lines with the exact value 566 or 568

566 & 568 cannot possibly find anything, since one Line only holds one 
single value

(20_30)¬25 will find all Lines with values in the interval 20…30, 
except 25

>=50 will find all Lines with values equal to or larger than 50
AT 4.1 Reference Manual Version 1 (31/12/99) 8  Analysis Templates  Common features 83



8  Analysis Templates  Common features 

H

84
You can switch between presentation forms in a menu,

which differs somewhat between the template types. All templates but the Cards 
template have at least one chart view.

Grid lines 
On the Options definition page, in all analysis templates but Cards, you have the 
option to improve the readability of data presented in table view:

You can enter gridlines horizontally between Every Line, Every Other, etc line 
in the output area. Vertically the alternatives are: No (vertical lines at all) or 
Every Column.

Decimals
You find it on the Options definition page in Cards, Lines, and Components. In 
Time Functions and Component Functions, it is available on each variable and 
formula page.

Example If you have a number 

123456789.123456789

in your HAT database, it will be displayed rounded to the closest number accor-
ding to the usual rules (i.e. 1-4 are rounded downwards, 5-9 upwards):

Note that the Decimals setting is only a matter of how the number is displayed. 
Its value in the database is not affected. 

Bastard zeros. In spite of showing a number with maximum precision, i.e. 
with six decimals, it may may look like a zero value, without actually being 
exactly zero (but very small), because of the rounding. 

If setting is …        it is displayed as…

6 123 456 789.123 457

3 123 456 789.123

1 123 456 789.1

0 123 456 789

-3 123 457’

-6 123’’
AT 4.1 Reference Manual Version 1 (31/12/99) 8  Analysis Templates  Common features 84



8  Analysis Templates  Common features 

H

85
Rounding when exporting and copying tables
Rounded values will be exported and copied in their displayed format, if they are 
rounded to zero or more decimals.  If rounded to -3 or -6 decimals, they are 
exported as if they were rounded to zero decimals.

Value fit and column width adjustment

Value misfit warning. Digits displayed with a double strikeout represent a 
value that does not fit in the column.

Adjusting column width. You can see the column borders by clicking on the 
column header while holding down the Ctrl key.

The arrow cursor ( ) changes to a column cursor ( ) at all column borders 

of the header. Drag the column pointer sideways to change the column width. 
The widths of adjacent columns will not be affected.

If you double-click with the column curser, the column width will automatically 
be adjusted. 

To adjust all columns simultaneously, use the command Set Column Widths, in 
the Edit menu. 

Changing Column order
If the column order is not satisfactory, you can drag columns into new positions. 
Click (and hold down the mouse button) in the header field you want to move. A 
dotted border, around this field, will be displayed. Drag the column horizontally 
to its new place. Its new position is indicated by a vertical bar ( ).

Zooming in charts

Enlarging by clicking
When you place the cursor on a chart area, it will show a magnifying glass. A 
simple click on a spot will give a new enlarged view (300%)

of the neighbourhood area.
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Enlarging by dragging
When you drag to mark an area with the magnifier, the area is enlarged to the 
new view.

Reducing Charts
By pressing the Alt-key, the cursor changes appearance from a magnifying glass 
to a ”reduction glass”. You can thus reverse the magnification. Note that you can 
also reduce by dragging. Try it, and you will quickly find out how it works.

Special case
In Component Functions, enlarging and reducing only works in one direction, 
along the value axis. 

Common definition pages
Each analysis template has a large number of features. They are organized in bet-
ween six and nine definition pages, depending on type of template. Some defini-
tion pages are specific for one type of template, but others are very similar. 

The definition pages Subsets, Printing, Export, and Notes basically look the 
same. The small differences that exist in a few cases, are further commented in 
the following sections. 

Subsets
This topic has essentially been covered in the section “Subsets” on page 59. The 
two types of subsets – Global Subsets and Local Subsets, were introduced in that 
section. They are both called Subsets, and you work in exactly the same way 
with both of them. Only their scope differ. A local subset is entered on a defini-
tion page, and is only valid within the template for which it is defined; hence we 
call it a Local Subset. On the Subsets definition page you can install a list of 
subsets. To enter a new subset, press the button New Subset. Note that you can 
also use the New command in the Edit menu. In order to enter a new subset this 
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way, you have to focus the Subsets list, by clicking anywhere in the list area, 
which will be highlighted. Then the command New Subset will show up:

With New Subset you get a regular subset window (i.e. the same as a subset in 
the Database menu). The subset is installed automatically when you close the 
subset window. You can install any number of subsets, and they all turn up in the 
Subsets list:

Mark an entry in the list, and the Edit menu will display the options to cut, copy, 
erase, and duplicate the highlighted subset. These operations can be performed 
also on any subcollection of subsets:

Printing
With one small exception, the Printing definition page always has the following 
contents:

Window Title. The name of the analysis template, as it appears in the window 
name, will be printed in the upper left corner of the printout.

Only shows when 
Subsets is active

Select All Highlights all the subsets

Shift-click Selects a closed interval of subsets

Ctrl-click Selects two or more non-consecu-
tive subsets
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Date and Time. Will print a date/time stamp in the upper right corner.

Page Numbers.  You can choose between how to display the pagenumbers, if 
at all. The page numbers will appear in the upper right corner of the document. 
Regardless of this setting, the pagenumber will not be printed at all, if the there is 
not more than one page in the printout.

Leave binding margin.  HAT will add another centimeter of space in the left 
margin.

Notes. The text in Notes will be printed below the window title, i.e. use it for 
written comments to the output.

Definition. Often you would like to see the exact definitions of the selections 
and formulas, that the printout is based upon.

Column Titles and Data Rows. Are also optional.

Header Rows. Are only relevant in some templates, e.g. the Lines template 
when the display mode is Table view.

Export
The Export commands are equivalent to the Copy Table and Copy Chart com-
mands. By exporting from an analysis template, you get a separate file.

You have a high degree of control of the format of the exported file. 

First the separators that are included (see section “Copy Table.../Copy Chart...” 
on page 39 for further details):

Then, the data that are included:

Time Functions 1                                     970701 18:42
This is a note

Months                              A
Before                                0
960731                     276 952
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Export… You can start the exportation in two ways. Either by pressing the 
Export… button on the definition page, or by choosing Export… from the File 
menu. 

Notes
For all types of analysis you can make a note about the contents of the analysis. 
The notes will be saved when the template is installed. It is sometimes a good 
idea to install the template with the Notes definition page displayed first: 
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Introduction
The Cards template is the least ”analytical” of the available templates. Still it is 
often very useful. Exactly how useful depends to a large extent it on what type of 
data the HAT-file represents. The Cards template is often used to examine the 
fundamental data in its pure form. The powerful search function in HAT is often 
used to find individual Cards containing certain texts in the Card Title or Line 
Text field. Or to find a a Card with a certain entry in the Value field.

Definition pages

Selection
See section “Selections” on page 75.

Subsets
See section “Subsets” on page 86.

Options

Data Contents

Groups = None. No Groups are listed (and therefore no Lines). The list  only 
contains the Card IDs and Card Titles: 

Gives a good overview for inspection of individual Cards. 
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Groups = All, Lines = All. All information on each Card, but for the Notes 
area, will be displayed:

One middle road: Groups = Selected, and Lines = Selected. 

Exactly the Lines which are included in the selection are displayed, no more and 
no less. 

In all there are nine different combinations of settings available.
AT 4.1 Reference Manual Version 1 (31/12/99) 9  Analysis Templates  Cards 92



9  Analysis Templates  Cards 

H

93
Decimals
See section “Decimals” on page 84.

Display Columns
Only the Card elements that are marked will show up.

Printing, Export, and Notes
See section “Printing” on page 87.

Working interactively in the output area
When you move the cursor over the output area, the arrow will turn into a cross-
hair symbol:

Click on a row in the output area, and the corresponding Card will be displayed, 
in edit mode. 

The individual element you clicked on will be highlighted, i.e. if you click on 
Fruit Import Ltd, you get:

If the Notes area contains text, it will automatically be opened.
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Introduction
The general idea with the Lines template, is to select individual Lines from their 
Cards, and present them in chronological order, in their detailed and ”raw” for-
mat. In addition to showing the individual values in lists or graphs, you can also 
get the accumulated figures. For all its simplicity, it is often very useful. The 
pop-up menu in the template common area allows you to display three different 
views:

Definition pages

Selection
See section “Selections” on page 75.

Subsets
See section “Subsets” on page 86.

Columns

Choose which Columns you want displayed.

Header lines
In Header Lines you can include general measures based on the contents of all 
the Lines in the list. The values will show up in a number of header lines in the 

Table view, where you can see the indi-
vidual values, and their accumulated 
values in two parallell columns

First chart view, showing the individual 
values in a bar chart.

Second chart view, which shows a line 
graph of the accumulated values
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first part of the output area. If all the entries are ticked it may look like this:

Sum Before. Net opening balance, i.e. the sum of all Line values which match 
the selection, and occur before the specified time period.

Positive. Sum of all positive values in the period.

Negative. Sum of all negative values in the period.

Period. 

First column: Net sum of all values in the period.
Second column: Includes the value of the entry balance, also.

Sum After. 
First column: The sum of all Line values that occur after the end of the specified 
time period. 

Second column: The first column plus the Sum After-value, i.e. it amounts to the 
sum of all Line values, from the first to the last in the file (which satisfy all other 
selection criteria, but for the time period).

Maximum. Returns values in two columns. The first number is the maximum 
value of all single values. The second number is the maximum value of all accu-
mulated values. 

Minimum. Analogous to Maximum.

Average. Returns values in two columns. 

The first column value is the average value of all single values. 

The second column value needs some further explanation. Mathematically it is 
the weighted average value of the accumulated values, where the weight for each 
value is its time span. 

Example If you have $20 in cash during the first week, and $10 during the following four 
week period, on average you had a balance of $12; calculated as (20x1+10x4)/5.
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Number of Lines. Returns the number of Lines in the list.

Turnover Time (days). The average lifetime in days of a value unit during the 
period.

Example Assume we have an average inventory level of 100 units during a period. During 
the same period we have on average filled up and delivered 5 units a day. The 
average time each unit stays in the inventory has been 100/5=20 days.

The mathematical definition is:

where

and

Turnover Rate (per year). The average number of times the mean value turns 
over per year. The relation to Turnover Time is this:

Interest. The interest rates entered in the boxes Positive balances and Nega-
tive balances are applied to the accumulated values. For every timespan with 
unchanged accumulated value, the first interest is applied if the balance is posi-
tive, and the second is applied if it is negative..

Example If you have a cheque account with a credit option, you normally get a lower inte-
rest on positive balances, and pay a larger interest on negative ones. If the Lines 
template includes the entry balance and the transactions, you will get the total 
interest value, split into positive and negative balances.

Linear or Exponential calculation. Depending on the terms of a loan or a 
bank account, interest is calculated in different ways. Usually the accumulated 
interest is added to the balance each year, with the effect that the entry balance 
for the next year changes accordingly. This, in turn, increases or decreases the 
total interest during the next year (the effect of “interest-on-interest”). Assume 
that an account starts with a fixed amount, and remains on the account for a num-
ber years without any transactions, but for the addition of the interest accumula-
ted during each year. The accumulated values (with the “interest-on-interest” 
effect) will then develop exponentially. E.g if the initial amount is $100 and the 

Turnover Time
s t( ) td∫

xi∑
 
  2⁄

------------------------=

s t( ) accumulated values as a function of time=

xi values=

Turnover Rate 365
Turnover Time
------------------------------------=
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yearly interest rate is 12%, the accumulated value would be $112 after the first 
year, $125.44 (=112+12%x112) after the second year, etc:

For periods within the same year, the interest is usually (but not always) strictly 
proportionate to the elapsed time. E.g. if the initial amount is $100 and the yearly 
interest rate is 12%, the accrued interest after three months is $3, after six 
months $6 etc:

To be able to cover these two cases, HAT offers two methods of calculating the 
interest:

1. Exponential, which corresponds to the first graph. Use this method if you 
want to calculate the interest over a number of years (when you want to 
include the “interest -on-interest” effect). It also gives the correct result for 
shorter periods if interest is accumulated continuously (which is seldom the 
case for common bank accounts, but more common in other cases).

2. Linear, as in the second graph. This model is often appropriate if the period is 
shorter than a year, or if you separately add one transaction at the end of each 
year, to account for the accumulated interest during the year.

Graphics
On this definition page you can set a number of options affecting how the graphi-
cal charts are presented, and to some extent what is presented:

The common purpose is to make the charts more readable.

10n. Especially for large numbers it is useful to present numbers in exponential 
format.

Years

Acc.
value

-96 -97 -98 ...

Months

Acc.
value

Jan Feb Mar Apr ...
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+/-. The value axis direction is reversed. Normally the positive axis points 
upwards. By clicking this checkbox the positive axis points downwards. The 
graphs will be presented, as if all values had the opposite signs. Useful when a 
lot of negative values are presented.

Grid Lines. Use this option to increase readability of diagrams.

Dates. You can change the time scale to any of the customized ones, provided 
you have at least one such time scale installed. If no such alternative exists, only 
the option Date (i.e. HATs own time scale) will be available.

Show Reference Line. A red vertical line will be displayed in the chart at the 
Reference Point (which you set in Database Settings…)

Show Today Line. A green vertical line is displayed, representing the current 
date.

Show Zero Line. A dotted horizontal line representing zero, will be displayed. 
It also ensures that the zero line is always shown in the graph.

Options
Apart from the button Relative Distribution, the settings on this definition page, 
influence how the Lines template looks in table view.

Decimals. Number of decimals displayed.

Card Info. This pop-up has two alternatives:

1. Every Line

The Card Info (i.e. Card ID and Card Title) is repeated for every Line item.
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2. First Line shows the Card Info only for the first line item, from the same 
Card:

Relative Distribution. When you push this button a frequency diagram will 
be displayed in a separate window

It shows how frequent different values are in the selection. You can enlarge the 
diagram in two ways:

1. By clicking in the graph, with the magnifier

2. By pointing and dragging, over the area of further interest.

3. With the Alt-key you modify the magnifying glass to  –  i.e. the reversed 

function.

Printing, Export, and Notes
See section “Printing” on page 87.
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Working interactively in the output area
You expose further details by clicking or dragging in the output area. 
The point-and-click operation can be used in all display modes – table view and 
the two variants of chart view. 
In chart view you can use the drag operation to define a list of cards, by marking 
a part of the output area.

To signal that these operations will take place if you click or drag, the curser 
turns into a crosshair-symbol. When data are displayed in table view, this hap-
pens already when you move the cursor over the output area, as this is the only 
possible meaningful operation. When the data are presented in any of the chart 
modes, the default operation when you click or drag is the zoom operation. You 
then have to press the Ctrl-button to modify the cursor to a crosshair-symbol, and 
get access to the ”drill down” functionality.

Table view
Click on any item 

and you will get the corresponding Card displayed, with a highlight of the field 
you pointed at:
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Chart view – Bar chart

Point-and-click operation. The mechanism is almost the same as in table 

view. With the difference that you have to press the Ctrl-key to change the arrow 
cursor to the crosshair. If you click on a bar, it will correspond to clicking on the 
Line value in table view.

Drag operation. In chart view you can drag over a number of transactions and 
get a list of them:

The transactions/bars which have their top ends in the marked area, are selected 
and displayed in a Cards template, with exactly these transactions selected.
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Chart view – Line chart

Point-and-click operation. Basically works in the same way, as for the bar 
chart (above):

You can only click on a vertical line segment, which represents a transaction 
value.

Drag operation. In this case you can only drag horisontally (i.e. along the time 
axis):

You get the selected transactions dated during the marked time period.
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Introduction
In the Cards and Lines templates you work on a very detailed level, with indivi-
dual values. In Components the focus is on aggregated values. E.g. if you want to 
see the costs by account, by profit centre, by project, by product, or any other 
dimension included in your HAT-application, you often use a Components temp-
late. In the example file, Demo Inc, we are limited to two dimensions by the 
available data – Account and Prof Cent.

The table and chart views
Data in a Components template can be presented as tables or as pie charts (which 
also hold some tabular data):

Table view
Use this view to see the exact aggregates by component. There are a number of 
different measures you can display, and you can show all of them, any subset, or 
just one. This is an an example where all available measures are used (each 
column gives one measure, see “Columns” on page 107.):

Usually only a few of these columns/measures are used in the practical case at 
hand. The table can be used for analysis by itself, or as a basis for copy-and-
paste or export, e.g. to an Excel spreadsheet, or any other application where 
tabular data are useful.
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Chart view
In the chart view, you can display one of the columns in table view, together with 
the corresponding pie chart. You choose which column, in the pop-up menu, situ-
ated in the output area heading.

Pie sectors. Each pie sector shows the value of a component as a fraction of 
the total for the Period. You can change to any other measure, corresponding to 
the measures on the definition page Columns.

Positive and negative component values in different pies. It is mea-
ningless to show positive and negative values in the same pie. Hence they are 
shown in separate circles, with areas proportional to their total values. 

Related pie sector and component value. By clicking on either a row in 
the table or a sector in the chart, you can see the correspondence between the 
two. Move the cursor away from the pie sector before releasing the mouse button 
if you do not want to expand the sector.

Changing colors. The table legend consists of colored labels (if you have a 
black and white display, the colors will be patterns instead). You can change the 
color/pattern of a label, by clicking on it. 

Left and right labels. The labels are arranged in separate columns for posi-
tive (to the right) and negative values (to the left). They are also a indented accor-
ding to their position in the dimension chart hierarchy.

Percentages. Are displayed according to settings on the Options definition 
page.

Black and white horizontal bars. The white bar shows the sum of all Line 
values. The two black bars show the sum of positive and negative values, as cur-
rently shown in the pie chart.

Total (net)value of
current selction

Negative pie value

Positive pie value

Positive pie

Negative pie
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View

The View menu allows you to instantly change the dimension, along which the 
selected data are aggregated: 

This flexible way to get aggregates by dimension components is a distinctive fea-
ture of the Components template (and in the Component Functions template, 
Chapter 13).

Definition pages

Selection
See section “Selections” on page 75.

Subsets
See section “Subsets” on page 86.

Columns
Determines which data are displayed in table view.

Example If you set Columns to:

you get the following columns:

If and how a column is displayed, is set with the pop-up menu for the co-
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lumn:

All the column values depend on the time interval defined on the Selection 
definition page. In the illustration that follows, the time points (i.e. 
Card IDs) From and To refer to the selected time period:

They define the Period, which is the basis for all other values, based on 
time intervals:

E.g. the value At End is the sum of all values, from the very first in the file 
(which also meets all other criteria in the selection, but for the time restric-
tion), until the Card ID entered in the To-box.

In addition to the measures illustrated above, the following ones are also 
available:

Negative, Positive. Splits the Period sum in its negative and positive parts.

Count. Gives the number of Lines in the selection.

No column for these values

The column is displayed, in the normal font style

The column is displayed, in bold face

time

From To

values

Before Period After

At End

Total
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Options

Components

Sorting
You can choose to sort components either on the basis of the structure in the 
dimension chart (Normal), or based on the component values in a column of 
your own choice. The sorting orders are:

The presentation follows the hierarchy defined in the 
dimension chart.

Shows each component at the lowest level, and every other 
component that is directly coded.

All components are displayed, regardless if they are 
directly coded or not.

Only directly coded components are shown.

Sorting 
order Explanation

The numbers  -4, -2, 0,1,3 
will be ordered as

As in dimension chart 3, -4, -2, 1, 0

By decreasing value 3, 1, 0, -2, -4

First by decreasing posi-
tive value, then increa-
sing negative, zero last

3, 1, -4, -2, 0

By decreasing absolute 
value

-4, 3, -2, 1, 0

By increasing absolute 
value

0, 1, -2, 3, -4

Zero first, then by increa-
sing positive, then decre-
asing negative value

0, 1, 3, -2, -4

By increasing value -4, -2, 0, 1, 3
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Values

Sublevels. Often, but not always, you want to see the aggregated values for 
high level components.

Decimals
See section “Decimals” on page 84. 

Presentation of the dimension charts
Controls how the dimension hierarchy is presented. You set this as a general pro-
perty of each dimension chart. You can overrule this setting here, if needed.

Display of percentages (appears in chart view, only)
Affects how percentages are displayed in chart view. 
The alternatives are: None, percentages without decimals, and with one decimal 
place.

Show Scale (appears in chart view, only)
Allows you to control if the horizontal scales will be displayed or not (see 
“Black and white horizontal bars” on page 106.):

Grid lines
See section “Grid lines” on page 84. 

Printing, Export, and Notes
See section “Printing” on page 87.

Working interactively in the output area
You basically have two different ways to explore more details in the output area 
of a Components template:

• Unfolding high level components to give a more detailed view, within the 
same template, using regular point-and-click operations.

• Showing the underlying details of a number or graphical element, with a 
transfer to a Lines template. In this case using the crosshair tool. 

Only the aggregates of directly coded 
components are displayed.

Each component aggregate includes 
directly coded values, and all sub-
level values.
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Unfolding components
You can expand a component to its subcomponents in two ways: 

• Click on the components hierarchy symbol or directly on the component text, 
e.g. CL Labour in the same way as you expand a component in a table.

• Click on the pie sector for the component.

Collapse component. There are two ways to collapse an expanded compo-
nent:

• Click on the components hierarchy symbol or the component text.

• Click on the inner pie sector for the expanded component.

Pie for subcomponent. If you expand all pie sectors in this example, you get 
overwhelmed by all its pieces. The remedy is to focus on a specific subcompo-
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nent. If you hold down the Shift key while clicking on a component, e.g. Oth 
Oper Expenses, the chart changes to:

This chart now corresponds to the values inside the frame. The black and white 
horizontal bar chart shows the relative size of this pie, compared to the original 
one.

To reverse this operation, Shift-click on the same component (Oth Oper Expen-
ses) again.

If you click (without holding down the Shift key) on a higher level component. 
the boxed area moves to that level. You will then have to expand this component 
to see its subcomponents.

Using the crosshair tool
The point-and-click method to successively unfold more details is often all you 
need. But if you want to see the individual transactions, this is not enough. You 
get these details, for a certain element in the output area, with a similar opera-
tion. Press the Ctrl-key, to change the cursor to a crosshair symbol and place it 
over a number or a pie-segment in the output area. When you press the left 
mouse button, you will get a new Lines template, which will show these very 
details.
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Table view
If you Ctrl-click on any number in the output area, the corresponding Lines will 
be displayed in table view. The header lines Sum Before, Period, and Number 
of Lines, will always be shown:

Chart view
Ctrl-clicking on any element (number or pie sector) in chart view of a Compo-
nents template, will produce exactly the same type of result. As in this example:

The target pie sector represents the period value 22 101, which is ”explained” in 
terms of the Line values that add up to this value (you find it the header line 
Period).
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Introduction
In Time Functions you typically select many subsets of data. For each subset you 
define a variable that holds a scalar measure of the selected values. Usually the 
most useful measure is the sum of all the selected values. But in some cases you 
choose another measure from the list of available alternatives (e.g. number of 
transactions, the average value, etc).

Based on the selection variables, you can build formulas of your own choice. E.g 
deviations of actual values from budget values, ratios between profit and sales, 
etc. 

The results are presented as functions of time. In a table of numbers (table view) 
or graphically (chart view). 

At any instant you can change the basic time unit, which defines the time resolu-
tion. There is a long list of such resolutions, which are predefined in HAT. The 
available alternatives span from yearly measures, down to single Cards or Line 
items. You can also use your own, customised, time scales.

Definition pages

Variables
The Variables page is the most prominent of the definition pages:

If you have not made any special changes to the default template (with Set 
Defaults), the first Variables page will be an empty page named A. With the 
pop-up menu which currently has this name in it, you can create two things:

• a New Selection, i.e. another selection variable which allows you to specify a 
measure based on the usual selection boxes. 

• a New Formula, where you can define a formula with selection variables, and 
perhaps with other formula variables, as elements.
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Defining selection variables

The selected Lines
You enter selections in the same way as in all other templates, e.g Actual Costs:

The names

Variable name. ’A ’ is the default name, which you can change to any other 
name in the right box. In addition to letters and numbers, the dot, space and num-
bersign (#) characters are allowed in a name. All other characters will be chan-
ged to a dot. 

Example If you enter the string

’Actual&Costs’ 

HAT will change this to 

’Actual.Costs’ (with a dot instead of the ampersand)

Title.  The Title box

will not show up unless the Show box is ticked. Enter any text string to be a title 
in the column for this variable. If you leave it empty, the name of the variable 
will be used instead.

The measure
The two pop-up menus to the right of the From and To boxes, define what mea-
sure to use.

First pop-up menu. Choose any of 

Sum is certainly the one you will use most frequently, but occasionally any of 
the others is useful.

Count Number of Lines

Sum Sum of values in the selection

Product Product of values in the selection

Average Arithmetic medium

Geom. Mean Geometric medium

Maximum Largest value

Minimum Smallest value

First First value

Last Last value
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By Period or From Start. The transactions in the selection could be spread 
along the time axis something like this:

If the basic time unit has been set to e.g. Month, and the type of measure to 
Sum, you can choose to sum these transaction values By Period (i.e. by month) 
or From Start. They are both illustrated in this chart:

showing which intervals are used for calculating the measure. If the measure is 
based on Sum, 

• each By Period value will be the sum of values during the month

• each From Start value will be the sum of values from the very first value, 
until the end of each month. In other words – the running total, or accumula-
ted value over time.

In chart view a selection variable set to By Period, is always displayed as a bar 
chart:

By Period

From Start
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But if it is set to From Start, it is always a line chart:

In the bar chart, the area of a bar corresponds to the total transaction value during 
the month. The accumulated values in the line chart are exactly correct at the end 
of each month. The slope of the straight line segment between two such values 
may be conceived as showing the average rate of change between these values.

The same logic applies to the other measures. E.g. if the pop-up menus are set to,

you will get the average value of all transactions during each period. What hap-
pens if you set the second pop-up to From Start? 
The average value displayed at the end of each period will be based on all trans-
actions from the very first in the selection, until the end of the period. The aver-
age will thus be based on a successively larger number of transactions. So, for a 
certain selection, you often tend to get a curve that approaches the average trans-
action size, with successively smaller fluctuations:

The important thing to note is, that although you may tend to think of the From 
Start setting as representing ”accumulation” in the sense of successively adding 
period values, this is only true for the (very frequent) case where the first setting 
is Sum. In other cases you should consider how From Start is defined, to get a 
correct understanding of the displayed chart.

Defining Formulas
Based on selection variables, you often want to calculate other values, such as 
the deviation between actual figures and budget, return on investment (ROI), 
return on sales (ROS), liquidity ratios, and a multitude of other useful measures. 

Basics
We illustrate with a simple example – calculating the deviation of actual out-
come compared to budget values. Two selection variables have been defined:
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1. Actual costs by month, until the end of February 1997

2. Budgeted costs per month, for the same time period

By selecting New Formula in the pop-up menu, you get

The common way to express the budget deviance is to calculate the difference

Budget.deviance = Actual.costs - Budget.costs

but you sometimes want it expressed as a percentage, also (see below).

Enter the elements in the formula box, either by entering the full arithmetic 
expression from the keyboard, or by using the pop-up arrow in the upper right 
corner of the formula box. If you left-click on it, the variables will be displayed. 
Right-click will display the list of operators (F1+left-click is another alterna-
tive):

The latter method helps when you have long, descriptive, variable names.

MacOS
......................................................
The corresponding commands are:
Single click on the pop up-arrow to get the variables list, and Alt-click to get the 

......................................................list of operators.
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If we have chosen to display all values (from the selections and the formula), the 
result looks like this:

If we want the budget deviation expressed as a percentage, the following formula 
is one reasonable way to define it:

Budget.dev.pct = Budget.deviance/Budget.costs*100

This is our second formula, and the table will have another column:

Available operators

Operators in formulas. The elementary operators (+, -, *, and /) are usually 
all you need, but there are a lot of other operators that are useful in some cases:

Operator 
symbol Description

MacOS 
symbols

Time T Time, in years (i.e. T=0 at From date, 
T=0.5 at middle of first year, T=1 at 
end of first year, T=2 at end of second 
year, etc)

Arithmetic +   - Addition and subtraction

 *    / Multiplication and division

^ Power

sqr Square

sqrt Square root √

Exponential exp Natural (base e) exponential function

exp2 Base 2 exponential function

exp10 Base 10 exponential function

Logarithmic ln Natural (base e) logarithmic function
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MacOS
......................................................
The column ’MacOS symbols’ includes alternative Macintosh symbols. Note 
that they work in Macintosh only, you cannot port them to a Windows environ-

......................................................ment.

Operation by Time. The pop-up menu below the fomula box, allows you to 
define operations on consecutive period values. You may want to to see how the 
budget deviance accumulates over time, for example. To get these values calcu-
lated and displayed, set this pop-up to Add from Start. The values will be:

lg Base 2 logarithmic function

log Base 10 logarithmic function

Trigonome-
tric

sin Sine (argument in radians)

cos Cosine (argument in radians)

tan Tangent (argument in radians)

Rounding round Nearest integer ≈

up Upwards (to nearest integer) »

down Downwards (to nearest integer) «

int Integer part (i.e. round ”towards 
zero”)

frac Decimal part (i.e. keep decimal frac-
tion only)

Special abs Absolute value

sign -1 if argument negative, +1 if positive, 
0 if zero

ran Random number in interval [0-1]

pi Pi  (3.141592…) π

Operator 
symbol Description

MacOS 
symbols
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The full list of operations follows:

Switching between variables
When you work with a template using many variables, you often want to switch 
quickly from one variable to the other. Instead of changing it via the menu, you 
can simply click on its column header (provided it is displayed, of course).

Subsets
See section “Subsets” on page 59.

Axis Limits
The variables in a Time Functions template, may be defined for different time 
spans – depending on what is entered in the From and To time boxes for each 
variable. On the definition page Axis Limits you set the time span covered by the 
template, as a whole. 

Time Axis. The settings in the From and To boxes not only determine how the 
tables or diagrams are displayed. They also indirectly define the Before value, 
which will be explained further. 

Assume that the Time Axis is set to

Setting Meaning

No operation

Accumulate period values

The difference between consecu-
tive values. If applied to a selec-
tion variable, defined as Sum: 
From Start, the result will be 
same as Sum:By Period.

Multiplies consecutive values. 
Useful e.g. with index series, 
where multiplication is the basic 
operation

The quotient between successive 
values, i.e. the inverse of multipli-
cation
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for a certain selection, and that the transactions time series looks like this:

If the From date is changed to 960901, the series in all presentations (tables or 
charts) will begin at this date, but it will still be possible to refer to transactions 
before 960901. This is important in the (common) case where you want a selec-
tion variable to show the accumulated values, starting from an entry level defined 
by transactions preceding its starting point. 

If the Time Axis boxes in this example were set to 

it would implicitely define the following basic time scale:

Although any selection variable defined within this context, primarily is defined 
within the Time Axis time span, it can also ”reach” into the Before time span.

E.g. if the selection variable would be defined as Sum By Period for the time 
interval 

with the time scale is set to , the value intervals would be:

Time AxisBefore

Before 960930 961031 961130 961231
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The illustrated intervals have names corresponding to how they are named in the 
Time Functions table:

Value Axis. Sets the vertical limits, in chart view. 

Example You may want to always show the zero base line. Then use the setting:

If nothing is entered in these boxes, HAT will automatically adjust the scale, to 
encompass all values (without wasting any ”screen estate”).

Shortcut to the Axis Limits definition page. If a Time Functions template 
is displayed in chart view, you can click anywhere along the axis, in the outer 
border, to get the Axis Limits definition page displayed.

Options
On this definition page a lot of different settings are gathered. They are grouped 
in two sections – Graphic Presentation and Grid Lines.

Graphic Presentation. This section concerns the chart view only

Setting Meaning

Displays the values in exponential for-
mat

Changes the direction of the graphi-
cally displayed values, in the vertical 
direction. Note that the values themsel-
ves are not changed.

Displays gridlines in the diagram, verti-
cally and/or horizontally
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Grid Lines. These settings are only relevant for table view. Horizontally there 
are a lot of different options. Vertically you can choose between having a dotted 
line between every column, or none at all.

Printing, Export, and Notes
See section “Printing” on page 87.

Other settings

Chart and Table views
Use this pop-up menu to change between the chart and table views.

Time Scales
In the leftmost part of the output header, you control the time scale resolution, 
used to display the results. All entries above the dotted line are standard resolu-
tions, always available in HAT. Below the dotted line you will find the custom 
time scales which have been installed via Time Scales in the Database menu. 
Most of the standard resolutions are self-explanatory. But those with the word 
Active in them, may need further explanation. 
All the selection variables defined for a certain template, collectively define the 
set of Lines that are included in any of these variables. A Line in this set is called 
active, if it has a non-zero value. If a Group contains a Line which is active, also 
this Group will be referred to as active. And so on, up to the Day level. 

Example The menu is set to Active Cards, and the measure of the selection variable A is 
set to Sum: By Period . You will then get the sum of all Line values in each 

Determines what time scale to use. The 
built in time scale is called Dates. It is 
the only one available, if no custom 
Time Scale has been defined, in the 
Database Menu.

Displays vertical lines:

A red line representing the Reference 
Point (see Database 
Settings…page 67).

A green line showing current date, 
according to the system clock

The horizontal zero line is shown as a 
dotted line.

Controls how the bars are displayed: 
side-by-side, overlapped, etc.

Setting Meaning
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Card. The time scale will be rather detailed, too – including the ordinal numbers 
(-008, -022, etc):

Working interactively in the output area
As usual in HAT, the general idea is to show the underlying details, by simple 
point-and-click operations. You can click on tabular or graphical elements. The 
result will always be presented in table view. Whether the element you click on 
represents a ”pure” selection, or is the result of a formula, makes a distinct diffe-
rence.

Clicking on a selection variable element
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In the dialog window you specify along which dimension you want the number 
to be displayed in more details. The intrinsic time dimension is the default 
choice, but you can also choose one of the custom defined dimensions, instead:

The specification of the element will depend on the type of choice:

If the choice is Time. The full list of lines specifying the element, in terms of 
the underlying numbers, will be shown in a Lines template:

One of the custom dimensions. The corresponding Components template 
will be displayed, e.g. if the dimension is set to Account:

You will see the number specified by account, unfolded one level. By pointing 
and clicking you can reveal further details, as usual in a Components template.

Clicking on a formula element
You will be asked not only to decide what dimension to show, but also if you 
would like to see the formula value itself exposed in more detail, or rather see 
one of the underlying selection variables. Often you can just as well click on the 
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selection variable itself to achieve this, if it is displayed. 
The following type of dialog will show up:

The derived template depends both on the View and the Variable settings. 

If Variable is set to a selection variable (Actual or Budget in this example), you 
will get exactly the same result as if you had clicked on the selection variable 
element directly in the table. I.e. when View is set to Time you will get a Lines 
template, and when it is set to a custom dimension (e.g. Account), you will get 
the corresponding Components template, expanded to the first level, as already 
explained (see section “Clicking on a selection variable element” on page 126).

If Variable is set to a formula variable, such as Deviation (%) in the illustration 
above, you will get a formula expansion. The constituent elements of the formula 
will be displayed, with every formula element (which may be a selection, or 
another, lower level, formula variable) displayed in one column each. 
Depending on if View is set to Time or a custom dimension you get the follo-
wing derived templates:

View is set to Time. You get a Time Functions template, with the same reso-

lution as before. Change e. g. from Months to Weeks if you want another reso-
lution.

Note that the formula elements will always be displayed, also in the case where 
they are not displayed in the template from which it is derived.
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View is set to a custom dimension. Will produce a Components Functions 

template. The dimension component will be expanded to the first level. All the 
formula elements will be displayed (same as when View is set to Time).
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Introduction
This type of analysis template is very similar to Time Functions – instead of sho-
wing the results as functions of time, you get them as functions of any of the 
other – custom – dimensions. You can easily change between different views, 
e.g. from Accounts to Profit Centres. As for Time Functions you typically 
define a number of selection variables. By default the scalar measure of these 
selections is the sum of all the selected values. 

You can build a wide variety of formulas based on the selections. E.g deviations 
of actual values from budget values, ratios between profit and sales, etc. 

The results are presented as functions of the components in the selected dimen-
sion. Choose between presenting them as a table of numbers (table view) or 
graphically (chart view). 

Definition pages

Variables

Selection variables
Define and name variables in exactly the same way as for Time Functions. See 
section “Defining selection variables” on page 116. Only the differences will be 
further explored here.

The first entry of the second pop up-menu has aother name. It is called By 
Component, but corresponds directly to By Period, in Time Functions. You 
typically use the alternative From Start when you want a running total to 
be calculated.

To the right on the Variables definition page, you will find a few settings that are 
particular to Component Functions. 
Depending on if you are working in table or chart view, they look slightly diffe-
rent:

Sublevels. The alternatives are Exclude and Include:

Example In the common case where the measure on each component is the sum of all its 
values, the setting Sublevels : Include for the variable, will give the sum of all 
subsidiary component values, in addition to the directly coded values.

Exclude Only values that are directly coded to 
the component, are aggregated in the 
measure for the component.

Include All the sublevel values are included, 
also.
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Formulas
These are built in the same way as formulas in Time Functions. Only the availa-
ble operators differ in a few cases. 

Operators. See “Available operators” on page 120. Compared to that list of 
operators, one is not applicable to Component Functions, and two new operators 
should be added:

• The Time operator (T) is not relevant for Component Functions.

• Only the operator ! is special for Component Functions. It designates specifi-
cally the highest component, excluding all sublevels (e.g. in a summation of 
all the values).

Sum: Before or After. If you have one variable which has values that repre-
sent quantities, and another that represents prices, the sum of the price-times-
quantity-values is probably what you would like to see in the hierarchical sums. 

Example You want to calculate price times quantity for the products in product group 1:

The value 115 is the sum of the values beneath 115, in the same column. This is 
what you get if you set this pop-up to Sum: After. It can be spelled out as fol-
lows: ”first calculate the formula values Total=Qty*Price, and then Sum them 
hierarchically After these calulations”.

If instead the pop-up is set to Before (i.e. the default setting) you would get the 
table:

i.e. the hierachical sums are calulated Before the formula (in this case 
Qty*Price) is applied to the resulting values. The Total will be 9*45=405, which 
is not very meaningful in this case.

Subsets
See section “Subsets” on page 59.

Qty Price Total

Group 1 9 45 115

   Product A 5 10 50

   Product B 3 15 45

   Product C 1 20 20

Qty Price Total

Group 1 9 45 405

   Product A 5 10 50

   Product B 3 15 45

   Product C 1 20 20
AT 4.1 Reference Manual Version 1 (31/12/99) 13  Analysis Templates  Component Functions 132



13  Analysis Templates  Component Functions 

H

133
Options
This definition page has a number of settings:

Components
The first menu allows you to choose between two display formats:

Hierarchical/Flat.  

All/In Use. 

Sorting

Sorting order. The alternatives are:

They are exactly the same as the sorting criteria in Components. See “Sorting” 
on page 133.

Sorting criterion. You can choose any of the displayed variables/formulas as 
the sorting criterion.

Grid Lines
Allows you to display gridlines both horizontally and/or vertically, to make the 
tables and graphics easier to interprete.

Hierarchical The components are displayed 
according to the way they are struc-
tured in the dimension chart.

Flat Only the lowest level components 
and directly coded components are 
displayed.

All All components are displayed, regardless if 
they are used to code any transaction in the 
database, or not.

In Use Components which are not used to code 
any transaction, are excluded.
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Other controls in Options

Printing, Export, Notes
See “Printing” on page 87.

Working interactively in the output area
To drill down in the output area, you work in exactly the same way as for Time 
Functions. 

Both numerical and graphical elements are ”clickable”: 

• When you click on a value defined by a selection you get the option to 
choose along which dimension you want the details displayed – the built-in 
Time dimension or one of the custom dimensions:

– Time produces a Lines template 

– a custom dimension will give a Components template showing data 
along the chosen dimension, expanded one level

• Clicking on a formula value gives you the option to get a formula expansion, 
i.e. all the elements of the formula will be displayed. Alternatively you can 
specify that any single one of the underlying selection or formula variables 
will be displayed in more detail. If you choose a selection variable, the result 
is equivalent to clicking directly on a value defined by the selection, and the 
result will be as described above. Choosing a formula variable will produce a 
regular formula expansion. See section “Clicking on a selection variable ele-
ment” on page 126.

Other Component Functions controls

View
You can easily change the dimension, along which all the values are displayed:

Instead of installing a number of templates of a similar kind, it is often better to 
install one single template, and then simply change this pop-up to get data pre-
sented along different dimensions.

Changes between different ways to display 
the components hierarchy.

Selects one of a number of bar chart lay-
outs. Only available in chart view.

The value axis direction is reversed; in 
graphical display, only.

Line spaces can be set from 1 to 6 lines.
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Automatic adjustment
This control is only available in chart view, in the low left corner of the window.

If the bar chart is not optimally adjusted to the window, you can click on the 
adjustment symbol.
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Introduction
The first part of the Window menu consists of operations on individual or groups 
of windows, the second part is a list of the currently open HAT windows:

Window commands
Zoom ..etc are all standard operating system commands. Only one of them 
requires a special comment.

Close All
Closes all open windows, including the database window. I you have a lot of 
open windows, this command provides a quick way to close them all, in one 
step.

But note that the database window

is one of them. It represents the entire database, i.e. if you choose Close All, you 
will get a dialog window asking if you want to close the database itself. Press No 
to to keep the database active. 

MacOS
......................................................
The Window commands are somewhat different: 
Zoom adapts the window to show as much as possible, using a minimum of 
screen area. 
Maximize expands it to the whole screen. You can also combine holding down 
the Alt-key while clicking the zoombox, to achieve this.
To close all windows with one command, click the closebox while pressing the 

......................................................Alt-key.
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Selecting a window
Use the Window menu to quickly switch between HAT windows. The currently 
active window is marked with . 

MacOS
......................................................
If, and only if, more then one database is opened by the same HAT application, 

......................................................the open templates will be grouped hierarchically under its HAT-file name.

Other aspects

Memory requirements
Each open analysis window is treated as an “analysis at work”, i.e. it uses space 
in the computer internal memory. You should therefore avoid having too many 
HAT windows open at the same time.

Alternative closing commands
You can also use the close box, if the window has one.

The Enter key can be used to close a Card window.
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Introduction
This menu only contains three elements:

• Help ...

• HAT User´s Manual ...

• About HAT ...

Commands in the Help Menu

Help...
Much of what you will find in this manual is also covered in HAT Help. Use 
HAT Help as an instant source of information in the moment a question arises. 
When you activate the Help-command, you get the Help for HAT window (to 
the right, below). A click on the Contents window button, displays a systematic 
view that follows the HAT menu logic (left picture):
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By clicking on the underlined text elements you get directly to the corresponding 
subject. For further information on how to use HAT Help, see the instructions in 
the Help itself.

MacOS
......................................................
No specific Help is available for Macintosh. Macintosh users are instead refered 

......................................................to this manual for information on how to operate HAT.

HAT User´s manual ...
This menu element is only available if the file HATmanual.pdf resides in the 
same folder as the HAT program. To be able to open and read this file you have 
to have Acrobat Reader installed on your computer. Acrobat Reader is a free 
software from Adobe Systems Inc. You can download the latest version from 
many Internet sites, e.g. from 

http://www.adobe.com

About HAT…
About HAT gives general information about HAT, and the option to subscribe to 
information about HAT.

MacOS
......................................................
You will find the corresponding information in the menu under the -menu, 

......................................................when the HAT-program is the currently active application.
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Introduction
You can “program” HAT to perform a series of tasks that you normally do by 
interacting with the HAT user interface. With HAT Macros you can automate 
long chains of tasks, which may not only be time consuming, but also prone to 
handling errors. You can also make life simpler for an occasional user of an HAT 
application – by installing macros that only requires the user to be able to find 
the Execute menu, and release the mouse button on the appropriate menu ele-
ment. 

A HAT Macro is a series of commands/steps, which are described in a HAT 
Macro script. 

Example The following macro updates a HAT database and saves it to the file ready.hat 
(for another example, see “Creating macros” on page 65.):

The script consists of a number of text lines. One line for each command, and at 
least one line for each comment. 

Often, but not always, a command has one or more parameters. These parame-
ters can be names of templates, names of other macros, and a lot of options con-
trolling different aspects. E.g. the Save command, 

Save  “C:\data\ready.hat”  FN   P-  M-

from the script above, has been specified to save the database to a file named 
ready.hat in the directory C:\data\, in the regular Analyser format (FN), exclu-
ding the Protection (P-) and the Macro (M-) sections. 

Spaces are important. The commands and the parameters are separated by 
whitespace (space or tab characters). The number of whitespace characters bet-
ween the options does not matter, but one single whitespace in the wrong place 
can change the meaning of the script, and make it unintelligible for HAT. Many 
parameters have themselves whitespace characters in them. Use “double quotes” 
around such a string, and HAT will interprete it as one single entity. E.g. the 
Import command in the example (above) has the parameter

“C:\data\new\fresh update.hat”

// global definitions

Signature    AG

// remove outdated cards and lines

DeleteCards  950101  951231

DeleteData   Filters:Subsets:Badcards

// import fresh data

Import  “C:\data\new\fresh update.hat”  -pw bingo

// save the updated database

Save  “C:\data\ready.hat”  FN   P-  M-
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Without the qoutes it would be interpreted as two separate semantic entities, 
because of the space after fresh. An empty parameter can be defined by “”. 

Comments. Use them extensively. They make it much easier to understand a 
script. There are two comment formats in a HAT Macro script:

HAT Macros and Commands Section
The Commands Section is an optional section in a HAT file which has the HAT-
Text file format. It is primarily used as a component in batchoriented types of 
tasks, e.g. for automatically producing HAT files from external host systems. 
The syntax and the commands in a Commands Section are identical to those in a 
HAT Macro.

Commands

Syntax of command descriptions

Note on pathnames. The rules for pathnames are those common to all Win-
dows systems:

• Directories are separated by a backslash (\).

• Double point (..) refers to the parent directory.

• Full pathnames use the format format drive:\dir\file, where the directory part 
(dir\) may occur zero or more times.

Line comments //Comment text Can only be used for 
single line comments

Block comments /*Comment
text*/

A comment has to start 
with /* and end with */, if 
it extends over many li-
nes

Element Meaning Examples

{dim} dimension number in range 
1 to 12.

7, for the seventh dimen-
sion

{template} A full template pathname. 
Parts are separated by a 
colon (:)

“Costs:By category”

{filename} A valid file pathname, 
either a full or a partial 
pathname. Partial pathna-
mes start at the directory 
where the original docu-
ment file is located.

Full pathname:

C:\data\ready.hat

Partial pathname:

“..\ready.hat”
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• Filenames are not case sensitive.

MacOS
......................................................
• Folders are separated by a colon (:).
• Partial pathnames begin with a colon, which in most cases can be omitted.
• Double colon (::) refers to the parent folder
• Full pathname uses format volume:folder:file, where the folder part (:folder) 
     may occur zero or more times

......................................................• File names in are not case sensitive.

Details by command

Execute   {macroname}

Executes the macro named {macroname}.

Circular calls are not supported.

ErrorFile   {filename}

Defines a file which logs the error messages. Most of the error messages ocur-
ring after this command are placed in a new file called {filename}.

Only fatal error messages are displayed in alert dialogs.

Any previous error log file is closed.

The error message file name is stored in the database for later use. It is in effect 
as long as the database is open.

Signature   {sign}

Defines a signature to be used in data operations.

By defining the signature this way you avoid the dialog when the signature is 
first needed.

Password   {password}

Defines a password for the current database.

Transform   {template}   {option}   {option}   {option}   ...

Opens or activates the given template, calculates it, transforms all data in the 
active window, and finally closes the template window.

The {template} element can be:

– Base which means the complete database

– a global subset name

– an analysis template pathname (Cards and Lines only)

The following options are avaliable:

Option Explanation

A Add a transformed duplicate

D{dim}={expr} Dimension expression, e.g. D3=\ 
clears dimension 3.

V={expr} Value expression. Letter A refers 
to the current value, e.g. V=A*2
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DeleteData   {template}

Opens or activates the given template, calculates it, deletes all data in the active 
window, and finally closes it.

The {template} element can be:

– Base which means the complete database

– a global subset name

– an analysis template pathname (Cards and Lines only)

DeleteCards   {fromCardID}   {toCardID}

Deletes cards in the given Card ID interval, from the database. Partial or totally 
omitted Card IDs are allowed. If so, they are interpreted as when entered in the 
correponding Card ID box, in an analysis template.

DeleteComponent   {dim}   {component}   {options}

Deletes components in dimension {dim}. The dimension can be specified by its 
number or its name. The component is specified by its HAT-code. A group of 
components can be deleted by specifying the group component. Components 
that are in use, cannot be deleted.

Options (one only):

DeleteSubset   {subset}  {subset} ...

Deletes global subsets. Subsets can be specified by name or by using the follo-
wing options:

Multiple subsets can be specified in a single command..

CB={expr} Card-ID source “Start” expression

CE={expr} Card-ID source “End” expression

CF={expr} Card-ID destination “Start” 
expression

CT={expr} Card-ID destination “End“ 
expression

TF={expr} Card title “From” expression

TT={expr} Card title “To” expression

LF={expr} Line text “From” expression

LT={expr} Line text “To” expression

NF={expr} Notes “From” expression

NT={expr} Notes “To” expression

silent Supresses error messages

all all subsets are deleted

filter {string} only subsets with names mat-
ching the string, are deleted
AT 4.1 Reference Manual Version 1 (31/12/99) Appendix A  HAT Macros  Reference 146



Appendix A  HAT Macros  Reference 

H

147
DeleteTemplate   {template}  {template} ...

Deletes analysis templates. Templates can be specified by name, group name or 
by using following options:

Multiple templates and options can be specified in a single command.

OpenTemplate   {template}

Opens and calculates the given template.

{template} can be:

– a global subset name

– an analysis template pathname

– pathname of an analysis template group

The command has the same effect as ticking the “Open Directly” checkbox 
when installing a template. When used in a Commands Section, the “Open 
Directly” feature is inhibited.

Note: It is not necessary to open a template (i.e. use this command) before using 
other template commands, e.g. the Transform, DeleteData, Print or Export com-
mands.

Modify   {template}   {selector}

Modifies the given template. {selector} uses the same format as template data in 
template sections, but fields are separated by whitespace.

Print   {template}

Opens or activates the template, calculates it, prints it to the current printer and 
finally closes the window. A group of templates can be specified as well. All the 
templates in the specified group are then printed.

Export   {template}   {filename}

Opens or activates the template, calculates it, and exports it to a file with the 
given filename. Finally, the window is closed.

Filename is optional. If no filename is specified, a default filename is used. This 
name is formed from the template pathname, according to the following conven-
tion, depending on operating system:

MacOS
......................................................
......................................................the name separator (:) is converted to slash (/)

Import   {filename}   -s {importsetup}   -pw {password}

Imports the given file into the database.

An import setup can optionally be specified in {importsetup}.

Opening password can optionally be specified in {password}.

all all templates are deleted

filter {string} only templates matching the 
string are deleted

Win-32 the name separator (:) is con-
verted to semicolon (;)

Win-16 only the last part is used
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If the imported file is protected and no password is given here, the user will be 
asked for the password.

Note: The password is displayed here, in plain text. This may constitute a general 
security hazard. Use the option to require a password, to open a macro script. 

Save   {filename}   {option}   {option}   {option}   ...

Saves the current database using the given name and options. The options are:

FT File format = Text

FN File format = Analyser

FB File format = Browser

FZ+ File compression on

FZ- File compression off

Fs Set database name and type

P+ Include Protection section

P- Exclude Protection section

B+ Include Database Settings section

B- Exclude Database Settings section

s+ Include Save Setup sections

s- Exclude Save Setup sections

s={name} Use Save Setup named {name}

I+ Include Import Setup sections

I- Exclude Import Setup sections

S+ Include Time Scale sections

S- Exclude Time Scale sections

M+ Include Macro sections

M- Exclude Macro sections

D+ Include Dimension sections

D- Exclude all Dimension sections

D{dim}+ Include Dimension section {dim}

D{dim}- Exclude Dimension section {dim}

D{dim}A Include only Active components in 
dimension {dim}

D{dim}U Include only components In Use in 
dimension {dim}

C+ Include Cards section

C- Exclude Cards section

C{dim}C Use HAT-codes for dimension 
{dim} in cards

C{dim}H Use host codes for dimension {dim} 
in cards

C{dim}T Use dimension texts for dimension 
{dim} in cards

CT Include cards/lines referred in temp-
lates only
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Close   {window}

Closes all windows with the name {window} in the current database. Changes 
made in those windows are lost.

Close

Close command without any parameters closes the current database. The data-
base is closed after the execution of all other commands.

The dialog for saving changes made to the database is not presented.

Quit

Terminates the HAT application, after execution of all other commands.

The dialog for saving changes made to any open database is not presented.

Beep

Sounds the system speaker.

U+ Include global subsets

U- Exclude global subsets

T+ Include Template section

T- Exclude Template section

TO Include open templates only

T={filter} Template filter string

F+ Include Analysis Defaults section

F- Exclude Analysis Defaults section
AT 4.1 Reference Manual Version 1 (31/12/99) Appendix A  HAT Macros  Reference 149


	1 Using the manual
	Purpose and scope
	The example file – Demo Inc
	Navigating in the manual

	2 General about HAT
	The rationale of HAT
	The problem
	The HAT solution

	Fundamental concepts
	The reality
	Business transactions and documents
	The contents of the documents

	The structure of data in HAT
	Cards and Lines
	An intermediate level – Groups

	Dimensions
	Types of dimensions


	HAT-data in the computer
	The HAT database and the HAT-file
	Structure of a HAT database
	Structure of a HAT-file
	Three file formats
	Relation between a HAT database and its HAT-file


	Operating systems and hardware
	Computer platforms
	HAT-processors

	Multiple users

	3 File Menu
	Introduction
	Commands in the File Menu
	New
	Open…
	Information in the database window
	All
	Active
	In Use


	Close
	Save
	Save As…
	Save Special
	Formats
	File Format
	Compressed

	Sections
	Characters
	Protection
	Base Options
	Save Setups
	Import Setups
	Time Scales
	Dimensions
	Cards
	Subsets.
	Analysis Templates
	Analysis Defaults

	Dimensions
	Cards
	Only cards and lines needed for templates
	Selection

	Templates
	Specifies which templates are saved with the file.
	Template Name Filter
	Currently Open Templates Only

	Rearrangements
	Dimension Numbering
	Dimension Codes in Cards

	Install
	Name for this Save Setup

	Save As ...

	Protection
	Define password
	Change/Remove password

	Preferences…
	General
	Language
	User Interface
	Dragging
	Alerts
	Check for File Updates
	System Setup
	Associate File Types
	Register/Unregister OLE-Server

	Print…
	Printer Setup...
	Import Setups
	New Import Setup
	Delete Import Setup
	General
	Import Setup Name
	Show File
	Characters
	Character Set
	Character Conversions
	Exclude Chars
	Format
	Field Length
	Row Terminator
	Field Separator
	Decimal Separator
	Exclude Rows
	Number of file rows for Cards
	Number of file rows for Lines
	Structure
	Card Switcher
	Field definitions

	Card Indicator
	Line Indicator
	Card Fields
	Date
	Date Format
	Date in HAT and the ”millenium problem”

	New Components in Hierarchy
	Card Title and Notes
	Other Card Fields
	Line Fields
	Introduction – Single versus Multiple Line Fields
	Specifying the Line Fields
	Value
	Scale Values By
	Exclude Zero Lines

	Dimension components
	New Components

	Multiple value columns structure

	Import…
	Export…
	Exit


	4 Edit Menu
	Introduction
	Commands in the Edit Menu
	Cut
	Copy
	Copy Table.../Copy Chart...
	Copy Table...
	Copy Data
	Separators

	Copy Chart...
	Copy Data
	Chart Size


	Paste
	Erase
	New
	Duplicate
	Select All
	Expand All
	Set Column Widths


	5 Database-Dimensions
	Introduction
	Basic Concepts
	Components in a Dimension Chart
	HAT-Code, Text and Host Code

	Properties
	Names
	Options for Analyses
	Display in data fields
	Must be filled in

	Fields
	HAT-Code
	Text and Host Code


	Viewing a dimension chart
	Hierarchy symbols
	Expanding a component with the mouse
	Expand the entire dimension chart
	Expand all subcomponents

	Expanding/collapsing with the keyboard

	Changing structures
	Moving components with the mouse
	Moving components with the keyboard

	Adding components
	Deleting components

	6 Database-Other commands
	Introduction
	New Card
	Editing a Card
	Header and footer edit boxes
	Card ID
	Card Title and Notes
	Fields in the Card body
	Dimension components

	Value field entries


	Delete Card
	Examine, Approve
	Signature

	Transform…
	Introduction
	Data affected by transform
	Add generates new data

	Transform operations
	Replace current dimensions with
	Card ID
	Card Title, Line Text, Notes
	Value
	Signature
	Splitting Cards during transformation
	Some potential effects of a transformation



	Delete Data
	Subsets
	Ordinary selections vs Subsets
	Combine many selections
	Use more fields in the selection criteria

	Cards and Groups operators

	Time Scales
	New Time Scale
	Importation to a Time Scales window

	Macros
	Creating macros
	Name
	Steps
	Show in Execute Menu
	Password required for this window


	Database Info
	Database Settings...
	Cards
	Card ID
	Decimals

	Reference point
	Alternative Titles

	Signature…

	7 Analysis-Overview
	Introduction
	Cards
	Lines
	Components
	Time Functions
	Component Functions
	Set Defaults
	Install Template
	Template Name
	Open Directly
	Calculate Directly
	Zoom Directly
	Fixed Position
	Add

	Remove Template

	8 Templates-Common features
	Introduction
	The Analysis template
	Definition page menu
	The Calc button

	Selections
	Selection Boxes - Dimensions
	Entering single components
	Selecting with mouse control
	Selecting with keyboard control
	Text entry from the keyboard
	Node Finder

	Entering component expressions, using operators
	The component operators
	Combining component sets with operators
	Feed back

	Selection Boxes - Time
	Default time limits
	Editing time limits
	From box
	To box

	The time operators
	Time offsets
	Using your own Time Scales

	Selection Boxes – Text
	Simple search texts
	Advanced search texts
	Logical operators

	Selection Box – Value
	Table and Chart views
	Grid lines
	Decimals
	Bastard zeros

	Rounding when exporting and copying tables
	Value fit and column width adjustment
	Value misfit warning
	Adjusting column width

	Changing Column order
	Zooming in charts
	Enlarging by clicking
	Enlarging by dragging
	Reducing Charts
	Special case

	Common definition pages
	Subsets
	Printing
	Window Title
	Date and Time
	Page Numbers.
	Leave binding margin.
	Notes
	Definition
	Column Titles and Data Rows
	Header Rows

	Export
	Export…

	Notes



	9 Analysis-Cards
	Introduction
	Definition pages
	Selection
	Subsets
	Options
	Data Contents
	Groups = None
	Groups = All, Lines = All
	One middle road: Groups = Selected, and Lines = Selected

	Decimals
	Display Columns
	Printing, Export, and Notes

	Working interactively in the output area

	10 Analysis-Lines
	Introduction
	Definition pages
	Selection
	Subsets
	Columns
	Header lines
	Sum Before
	Positive
	Negative
	Period
	Sum After
	Maximum
	Minimum
	Average
	Number of Lines
	Turnover Time (days)
	Turnover Rate (per year)
	Interest
	Linear or Exponential calculation

	Graphics
	10n
	+/-
	Grid Lines
	Dates
	Show Reference Line
	Show Today Line
	Show Zero Line

	Options
	Decimals
	Card Info
	Relative Distribution

	Printing, Export, and Notes

	Working interactively in the output area
	Table view
	Chart view – Bar chart
	Point-and-click operation
	Drag operation

	Chart view – Line chart
	Point-and-click operation
	Drag operation



	11 Analysis-Components
	Introduction
	The table and chart views
	Table view
	Chart view
	Pie sectors
	Positive and negative component values in different pies.
	Related pie sector and component value
	Changing colors
	Left and right labels
	Percentages
	Black and white horizontal bars

	View

	Definition pages
	Selection
	Subsets
	Columns
	Negative, Positive
	Count

	Options
	Components
	Sorting
	Values
	Sublevels

	Decimals
	Presentation of the dimension charts
	Display of percentages (appears in chart view, only)
	Show Scale (appears in chart view, only)
	Grid lines
	Printing, Export, and Notes

	Working interactively in the output area
	Unfolding components
	Collapse component
	Pie for subcomponent

	Using the crosshair tool
	Table view


	12 Analysis-Time functions
	Introduction
	Definition pages
	Variables
	Defining selection variables
	The selected Lines
	The names
	Variable name
	Title

	The measure
	First pop-up menu
	By Period or From Start

	Defining Formulas
	Basics
	Available operators
	Operators in formulas
	Operation by Time

	Switching between variables
	Subsets
	Axis Limits
	Time Axis
	Value Axis
	Shortcut to the Axis Limits definition page

	Options
	Graphic Presentation
	Grid Lines

	Printing, Export, and Notes
	Other settings
	Chart and Table views
	Time Scales

	Working interactively in the output area
	Clicking on a selection variable element
	If the choice is Time
	One of the custom dimensions

	Clicking on a formula element
	View is set to Time
	View is set to a custom dimension



	13 Analysis-Comp functions
	Introduction
	Definition pages
	Variables
	Selection variables
	Sublevels

	Formulas
	Operators
	Sum: Before or After

	Subsets
	Options
	Components
	Hierarchical/Flat
	All/In Use

	Sorting
	Sorting order
	Sorting criterion

	Grid Lines
	Other controls in Options
	Printing, Export, Notes

	Working interactively in the output area
	Other Component Functions controls
	View
	Automatic adjustment


	14 Window Menu
	Introduction
	Window commands
	Close All

	Selecting a window
	Other aspects
	Alternative closing commands


	15 Help Menu
	Introduction
	Commands in the Help Menu
	Help...
	HAT User´s manual ...
	About HAT…


	Appendix A-HAT Macros
	Introduction
	Spaces are important
	Comments
	HAT Macros and Commands Section

	Commands
	Syntax of command descriptions
	Note on pathnames

	Details by command
	Execute {macroname}
	ErrorFile {filename}
	Signature {sign}
	Password {password}
	Transform {template} {option} {option} {option} ...
	DeleteData {template}
	DeleteCards {fromCardID} {toCardID}
	DeleteComponent {dim} {component} {options}
	DeleteSubset {subset} {subset} ...
	DeleteTemplate {template} {template} ...
	OpenTemplate {template}
	Modify {template} {selector}
	Print {template}
	Export {template} {filename}
	Import {filename} -s {importsetup} -pw {password}
	Save {filename} {option} {option} {option} ...
	Close {window}
	Close
	Quit
	Beep




